
 

Movavi Video Suite
 

What do you need help with today?
Removing trial restrictions

Activate Movavi Video Suite save videos without a watermark and remove all restrictions.
Recording screen

Capture any fragment of your screen or the full desktop.
Editing video

Create a movie from videos and photos
Capturing video

Record video from a camera.
Cutting video

Cut video files into multiple files or cut out scenes.
Burning files to DVD

Burn files and videos to DVD, create audio CDs.
Upload files to the web

Upload videos and photos to social networks in bulk.
 

Need more help?
Write to us at support@movavi.com

Or click here to open live chat.
 

mailto:support@movavi.com
https://chatserver.comm100.com/ChatWindow.aspx?planId=1190&visitType=1&byHref=1&partnerId=-1&siteid=27345
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Removing trial restrictions
When you first start your copy of Movavi Video Suite, it will be running in LIMITED TRIAL MODE. In trial mode, you can try
out all of the main features, but the following trial restrictions will apply:
 
TRIAL VERSION FULL VERSION

 Movavi Video Suite will stop working after 7 days  Lifetime license

 A watermark with the words ' trial version' will be added to
all output videos

 No annoying watermarks

 Capture time is limited to 2 minutes per video  Unlimited capture time

 You can only convert half of each audio file and half of
each video if you use SuperSpeed mode

 Unlimited video and audio conversion

  Free updates
  Discounts on other Movavi products and upgrades
 
In order to upgrade to the full version, follow the instructions below to activate Movavi Video Suite:
 
Step 1: Buy activation key
1. Click the button below to go to the purchase page and click the Buy Now button there.
2. You will be taken to our web store. Fill in your billing information and payment options and proceed with the purchase
form. IMPORTANT! Be sure to enter a valid e-mail address: it will be used to deliver your activation key.
3. Once you have placed your order, you will shortly receive a confirmation for your order and an e-mail from
support@movavi.com containing your activation key.

Step 2: Open the activation window
Open Movavi Video Suite and click Activate, or open any Movavi Video Suite module and choose Activate Software from
the Help menu to open the activation window.

http://www.movavi.com/suite/buynow.html?asrc=vs_help
http://www.movavi.com/suite/buynow.html?asrc=vs_help


 

 

Step 3: Enter your activation key
1. Enter the activation key into the corresponding box.
2. Click Activate to complete the activation.

Having problems with activation?
If activation is not working as expected, try the following:

• Make sure that the activation key is entered correctly and is intended for the program you are activating.
• Try activating offline via e-mail.
• Contact us at support@movavi.com and we'll help you solve the problem!

 
Activating without Internet access
If the computer you have installed Movavi Video Suite on is not connected to the Internet, you can activate the program via
e-mail.
See detailed instructions
 
I bought Movavi Video Suite, but my videos already have a watermark

mailto:support@movavi.com


 

 

If you saved the Video Editor project that you used before exporting the video, you can re-export the project again without
the watermark after you have activated the program.
How to export videos



 

 

Getting an activation key
You can get an activation key either from our official website or from any of our partners in your region. Follow the steps
below to buy an activation key from the Movavi website:
 
Step 1: Go to the purchase page
To open the purchase page for Movavi Video Suite:

• In the Help menu of any module, choose Buy Activation Key, or
• Follow the link below...

Step 2: Choose a license type

• If you plan to use Movavi Video Suite at home, click Buy Now on the purchase page to proceed with buying the personal
license.

• If you plan to use Movavi Video Suite at work, in a government institution, or gain profit in any way, click Business license
on the purchase page.

 
After that, you will be redirected to an online store depending on your region and the available payment methods. All of our
vendor partners are secure and completely safe.
 
Step 3: Fill in your billing details
1. Choose any of the available payment methods.
2. Fill in the information required on the page.
3. Enter a valid e-mail address. This e-mail will be used to deliver your activation key.
 
Step 4: Get your activation key
After the purchase has been verified, you will receive a letter containing your activation key. Now you can use it to activate
the program.
Activation instructions
Activating without Internet access

If you haven't received your activation key within the hour:

• Check the Spam folder of your mailbox
• Contact support

http://www.movavi.com/suite/buynow.html?asrc=vs_help
http://www.movavi.com/suite/buynow.html?asrc=vs_help
http://www.movavi.com/support/contact.html


 

 

Activating Video Suite
Activating Movavi Video Suite will allow you to remove all of the trial restrictions and use the program forever.
 
You will need:

• Movavi Video Suite activation key. You should receive your key via e-mail right after your purchase is completed. Don't
have a key? Buy now

• Internet access to verify the activation key. Don't have Internet access? See this guide on offline activation

 
Step 1: Open the activation window

• Open the Movavi Video Suite launcher and click the Activate button.
• Or launch any application in Movavi Video Suite, then open the Help menu and select Activate Software.

Step 2: Enter your activation key
1. Enter or paste your activation key into the corresponding box of the Activation window.
2. Click Activate to verify your activation key.

http://www.movavi.com/suite/buynow.html?asrc=vs_help


 

 

If you have entered the key correctly, you should see a message confirming successful activation.  Click OK to complete the
activation process and restart the program.

 
If online activation fails, try the following:

• Check that the activation key is entered correctly and is intended for the program you are activating.
• Try offline activation.

 
If you have any questions or problems while activating your Movavi software, please don't hesitate to contact our support
team.

http://www.movavi.com/support/contact.html
http://www.movavi.com/support/contact.html


 

 

Activating without Internet access
To enjoy all the benefits of Movavi Video Suite, you will need to activate the software using the activation key. The program
requires Internet access to verify the key. If you don't have Internet access on your computer, you can use any other
computer or mobile device to complete the steps that require a connection.
 
You will need:

• Movavi Video Suite activation key. You should receive your key via e-mail right after your purchase is completed. Don't
have a key? Buy now

• A device or another computer that can be used to send and receive e-mail.

 
Step 1: Open the activation window

• Open the Movavi Video Suite launcher and click the Activate button.
• Or launch any application in Movavi Video Suite, then open the Help menu and select Activate Software.

Step 2: Enter your activation key
1. Enter or paste your activation key into the corresponding field.
2. Select the Activate offline option.
3. Click Activate to proceed to the next step.

http://www.movavi.com/suite/buynow.html?asrc=vs_help


 

 

Step 3: Send an e-mail with the provided information
The next window contains important activation information that you will need to send us via e-mail in order to activate your
program.

1. Click the Copy button to copy the information in the window. If necessary, save or transfer this information to the computer
or device that you will be sending the e-mail from.
 
2. On the computer with an Internet connection, open your mail client and compose a new e-mail. Paste the information
you've copied earlier into the message body and send this e-mail to reg@movavi.com. The activation server will then verify
your activation key and send you an automatic response containing a registration key, which you will need to enter into the
Activation window. You should receive the server's reply within an hour.

 

mailto:reg@movavi.com


 

 

Step 4: Enter your registration key
1. When you have received your registration key, save it and go back to the Activation window.
2. Enter the registration key into the corresponding box.
3. Click Activate to submit the information.

If everything is correct, you will see a successful activation message. Click Finish to complete the activation and close the
activation wizard.
 
Once activation is complete, you may be asked to restart the application. If you have entered the key correctly, you should
see a message confirming successful activation.  Click OK to complete the activation process and restart the program.
 
If offline activation doesn't work:

• Make sure you have entered the activation key and the registration key correctly and try again.
• Check that you are activating the right application.
• Make sure you have administrator rights on your computer.



 

 

If you have any questions or problems while activating your Movavi software, feel free to contact us and we'll help you out!
Our e-mail: support@movavi.com

mailto:support@movavi.com


 

 

Edit video
Using the Video Editor, you can create your own movies using the media files you have on hand. 

How to use the Editor?
Step 1: Add media

Add videos, photos, and music to your video project.
Open captured videos in the Editor

Record video
Record audio

Arrange files chronologically
 

Step 2: Edit video
Edit and enhance the video clips to

make your video just the way you like it.
Cut and split video

Rotate clips
Crop the frame

Apply cool filters
Step 3: Join clips with transitions

Drag-and-drop transitions from the Video Editor's
extensive collection to join clips with fun animations.

Step 4: Annotate your video
Get your thoughts across with sound and text.

Record a voice-over
Add text titles

Step 5: Save your video
Export your project to a common video format.

Save for devices
Save for uploading online

 



 

 

Making a movie
Jump to:

Creating project | Adding files | Cutting clips | Editing clips | Filters | Titles | Transitions | Saving the video
Step 1: Open the Video Editor
Open Movavi Video Suite and click Edit video in the Video tab to launch the video editing module.

 
Step 2: Create a new project
When you open Movavi Video Editor, you will be asked to choose an aspect ratio for your new movie. Choose an aspect
ratio closest to that of the videos and photos you intend on using. You will be able to change this later.
Learn more about projects and aspect ratio

Step 3: Add videos, images and music
On the Import tab of the Video Editor, click Add Media Files to choose the video, audio, and image files you'll be using.
 

Learn more: Adding files | Recording video | Recording audio



 

 

When you open the files, they will be placed on the Timeline: the videos and photos on the video track, and the audio clips
on the audio track. To rearrange the clips, simply drag them to the necessary position with the mouse.

Learn more: Using the Timeline | Working with video and images | Working with audio

Step 4: Cut videos
1. Select the clip that you want to split*.
2. Move the position marker onto the moment where you want to cut the clip. You can move the position marker both in the
player or on the Timeline.
3. Click the scissors button on the toolbar to split the video into two parts.

Learn more: Cutting video | Cutting audio
 

* Note that if you select a video clip, its audio track will also be cut, unless you
move it to a separate audio track. Learn how to work with audio on the Timeline



 

 

Step 5: Edit and enhance clips
Select the clip you want to edit, and click the Tools button on the left to see clip editing options. Here, you can edit each
clip's speed and volume, as well as rotate, crop, and adjust the videos.

Rotating clips:
1. Click Rotate and Flip to open the rotation options.

2. Click the arrows to rotate the selected clip 90° clockwise  or counterclockwise .
Learn more about rotating clips



 

 

Enhancing photos and videos:
Auto adjustments can help you enhance your videos and photos in one click, making them more vibrant.
1. On the Tools tab, click Color Adjustments to open the adjustments for the selected clip.
2. Select the auto adjustments that you want to use. Magic Enhance will instantly fix the clip's brightness and contrast.
These enhancements are fully automatic.
Learn more about enhancements

Step 6: Add Filters
Filters can help you change the colors in your photos and videos or add an artistic touch. To apply a filter:
1. Click the Filters button to open the filter library. To preview a filter effect, click on its thumbnail.
2. Drag the filter's thumbnail down onto a clip on the Timeline to apply it. A star icon will appear on the clip.
Learn more about filters



 

 

Step 7: Add text titles
1. Click the Titles button to open the titles collection. To preview a title style, click on its thumbnail.
2. Drag the titles you like onto the top of the Timeline. The title track will appear. Place the titles where you want them to
appear relative to the other clips.
3. To change the text and edit the title style, double-click the titles clip you've just placed. The title properties panel will
appear in the player, where you can edit and move the text.
Learn more about adding titles

Step 8: Add transitions
1. Switch to the Transitions tab, where you can choose animations to smoothly join the clips.
2. Drag-and-drop a transition icon in between two clips on the Timeline.
Learn more about transitions



 

 

 
 
Step 9: Export the finished video
Make sure to save your work once in a while: choose Save from the File menu to save the slideshow project so that you can
access it later.
 
When you're done with the slideshow, click the Export button to open the exporting options. In the Export window, choose
a format you want to save the video in, and name your slideshow. Finally, click Start to begin processing the video. Your
slideshow will be ready in a few minutes.
Learn more about saving your video

Having trouble with something?  E-mail us and we'll help you out! Our e-mail: support@movavi.com
 
 

mailto:support@movavi.com


 

 

New project setup
First of all, you will need to create a new project and select some of its parameters.
 
Creating a new project
1. Open the File menu and choose New Project.
2. A dialog box will appear. Here, you can select the parameters of your future movie.
3. Choose an aspect ratio for your project by clicking the 16:9 or 4:3 button.
4. Click OK to continue with your project.

 
What is a project?
A project is a file with the *.mepx extension that stores all your work on the movie, including the order of videos on the
storyboard, and any other changes you have made while editing the video. Project files can only be opened with Movavi
Video Editor or Movavi Slideshow Creator.
 
What is aspect ratio?
Aspect ratio describes the proportions of the video frame, and is basically the ratio of the video's width to its height. When
choosing a project, you can choose between two most common aspect ratios: 16:9 and 4:3. 16:9 is the most common
aspect ratio used for digital videos, especially widescreen movies, while 4:3 is closer to a square, and was used for analog
television. 

A visual comparison of the two common aspect ratios
 
Ideally, the project's aspect ratio should match that of the photos and videos you plan to use in your movie. This way, all of
the photos will fit inside the frame nicely. If you add files with a different aspect ratio, they may appear to have black bars
around them, like so:



 

 

 
Adding 4:3 photos to a 16:9 project and vice versa

 
You don't have to choose the perfect aspect ratio right away, if you're unsure, you can always change this later in project
settings, or fit the images into the selected frame. 
Learn more about project settings
Learn how to get rid of black bars
 
Advanced settings
If you need to set other parameters, click the Advanced settings button in the project window. You will be able to choose
the following:
 
Frame size:
You can use this to choose a set frame size (width and height) of the project. If your photos have a different aspect ratio, you
can select Custom and enter the photos' width and height into the boxes below to set their proportions for the whole project.
 
Resize method:
This affects the way photos and videos are resized to fit the project's frame size. Photos with the same aspect ratio as that of
the project will fit in nicely, while others will need to be somehow adjusted in order to avoid black bars on the sides. You can
choose one of the following options:

• Letterbox - the photos and videos will retain their original proportions, and will be resized to fit inside the frame.
• Stretch - the photos and videos will be resized to fit inside the frame as best as possible, and then stretched to

fill the remaining space. This allows to fill the entire screen without black bars, but it may distort objects in the
photos.

• Crop - the photos and videos will be resized in such a way as to fill the entire frame without changing their
proportions at the expense of cropping away the edges. This allows to fill the entire screen nicely, but some parts
around the edges will not be visible.

 
Sample rate:
This affects audio quality. The default option, 44100 Hz, is suitable for most projects.
 
Channels:
This affects the number of channels in the project's audio. You can choose between mono (one channel) and stereo (two
channel) sound, but stereo is usually best for most projects.
 
If you want to change these later, open the project settings.
 
See also:
Saving your work
Project settings
Exporting your movie



 

 

Adding media files
To begin working on your video project, you will first need to add some media files to the Editor.
 
Open the Import tab
The Import tab contains options for opening and creating media. To open it, click the Import button in the upper left-hand
corner of the Video Editor window.

The Import tab is the first one you see when you open Movavi Video Editor.
Adding video, photo, and audio files
If the media you want to use is stored in a file, use the buttons in the My files section or drag-and-drop media files straight
from Windows Explorer onto the Timeline to add them to the project.

• To add one or several files from a single folder, click Add Media Files and choose the files you want to use.
• To add the contents of an entire folder, click Add Folder and select the folders you want to import.

Recording video
You can also record video from your webcam, record clips from a TV tuner or import files from a digital camera.
1. Click the Record Video button. The Video Capture module will open.
2. In the Video Capture window, set up your video and audio capture devices.
3. Click Start Capture to record the video.
When you're done, click Back to editing to import the recordings into the project.
Learn more about recording video



 

 

Using stock media
If your project is missing cool footage, music, or backgrounds, use the free stock clips included with the Video Editor.

 
Sample audio
1. On the Import tab, click the Sample audio section to open the free stock audio collection.
2. Click on an audio clip to preview it.
3. Once you've picked a clip you like, drag it onto the audio track of the Timeline.
To find more songs for your project, click Download more and subscribe to AudioBlocks.com — a stock audio bank where
you can find thousands of songs, themes and audio samples.
 
Stock video
1. On the Import tab, go to the Sample video section to open the free video collection.
2. Click on a clip to preview it.
3. Once you've picked a clip you like, drag it onto the video track of the Timeline.
If you can't find the right clip, click Download more and subscribe to VideoBlocks.com — a stock video collection with
thousands of royalty-free videos, footage clips and animations.
 
Backgrounds
1. On the Import tab, go to the Backgrounds section to open the free stock background collection.
2. Pick a background you like and drag it onto the video track of the Timeline.
For more backgrounds, click Download more and subscribe to GraphicStock.com. Here you can find backgrounds,
illustrations, vector graphics and design elements for every project.
 
Capturing screen activity
Click the Record Screencast button to open Movavi Screen Capture and record a new video.
Recording screen activity
 
Arranging files on the Timeline
Once you've added the files, they will appear on the Timeline at the bottom of the Video Editor window. The Timeline
allows you to arrange the clips in the order you want. The clips' position relative to the time markers at the top of the
Timeline determines when it will appear in the finished video. To reorder the clips, select the clips you want to move and
then click and drag them to the new position on the Timeline.
Learn about using the Timeline

http://www.movavi.com/stock-video-footage.html?http://www.movavi.com/stock-video-footage/?asrc=scs_other_import&app=screencapturestudio&module=videoeditor&app_ver=7-2-0&lang=en_us&partner=&istrial=0&huid=00ba7ea7d0a8f368e6c2ff9dacdbaf18a2dd717c&utm_nooverride=1


 

 

Moving a clip on the Timeline

See also:
Working with video
Working with audio
 



 

 

Recoding video

Follow the steps below to record video from a camera that's connected to your computer.
 
Step 1: Connect the camera you want to capture from to the computer. Make sure that the system recognizes the device
and that it is working correctly.
 
 
Step 2: On the Import tab of the Video Editor, click Record Video. The recording module will open in a separate window.

Step 3: In the Video capture device box, choose the camera you want to use for capture. Then, select the resolution and
frame rate. A larger resolution will be able to retain better quality, however, the video file size will be larger. A higher frame
rate is necessary for recording motion, while static scenes can be captured with a lower frame rate.
 
Step 4: In the Audio capture device box, choose the microphone that you want to record the sound with.



 

 

Step 5: (Optional) By default, the recordings will be saved to your Movavi Library folder. If you want to save them

somewhere else, click the folder button  under 'Save files to' and choose a different location.
 
Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up
the new file name template. 
 
Step 7: Click Start Capture to begin recording the video. During capture, you can take snapshots using the camera button

 on the right.
 
Step 8: To finish the recording, click Stop Capture. If you need to record more videos, repeat steps 7 and 8.
 
Step 9: When you're done, click Back to editing at the bottom of the window. The captured files will be added to your
project's Timeline. Also, they are saved to disk in case you want to use them later.



 

 



 

 

Recording audio
After you've added some videos and photos to the Timeline, you can record audio from a microphone or any other recording
device.
 
Step 1: Set up recording
1. On the toolbar, click the microphone button to open audio recording options.

2. In the Audio device box, choose the device you want to use.
 
To record from a microphone: choose your preferred microphone or webcam microphone. If you don't see the device in
the list, try reconnecting it to your computer.
 
To record audio from the computer: select Stereo Mix from the list. This will allow you to record any music, alerts, or other
sounds playing on your computer.
 
3. Set the volume level you want to use in your project.
 
4. On the Timeline, place the progress marker to where you want the recording to begin.



 

 

Step 2: Record sound
1. When you're ready, click Start Recording. You will be given a 5-second countdown.
 
2. The video will start playing simultaneously with the recording. This way, if you're recording a voice-over, you will be able to
use the video as a visual aid as you speak.
 
3. When you're done, click Stop Recording. The recorded audio clip will already be on the Timeline, as a linked audio clip.

audio_tracks.htm#linked_audio


 

 

Importing AVCHD video

Follow the steps below to import previously recorded videos from an AVCHD camera.
 
Step 1: Connect the camera you want to capture from to the computer, and enable USB connection mode on your camera.
Make sure that the system recognizes the device and that it is working correctly.
 
Step 2: On the Import tab of the Video Editor, click Record Video. The recording module will open in a separate window.

Step 3: In the Video capture device box, select your AVCHD camera.

Step 4: On the left, you will see a list of all clips on the camera storage. Review the files and deselect the ones you don't
need.



 

 

Step 5: (Optional) After importing, the files will be saved to your Movavi Library folder. If you want to save them somewhere

else, click the folder button  under 'Save files to' and choose a different location. 
 
Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up
the new file name template. 
 
Step 7: Click Add files to the Editor to start copying the files. This may take a while depending on the size of the videos.



 

 

Using the Timeline
Jump to: Timeline tracks | Zooming the Timeline | Previewing clips | Arranging clips | Position marker

 
The Timeline, located in the bottom part of the window, is the working area that allows you to organize and edit the clips. The
Timeline consists of several tracks, which are all synchronized to a single time scale at the top, which indicates the time of
the project.
 
Timeline tracks
The Timeline is made up of several tracks, one for each media type, that allow you to arrange the clips in chronological
order; mixing and joining the clips together to create your unique video.
 
Video track
The video track contains video clips and their attached audio, images, and transitions between clips.

• You can link audio and titles to video and image clips so that they will stay in sync as you edit the project.
• You can rotate, adjust, and use other tools on video and image clips on this track.
• You can apply filters to video and image clips on this track.

 
Linked audio track
The linked audio track contains audio clips that are linked to video clips. At the beginning of each linked clip, you can see a
blue line that connects it to the video or image clip it is linked to. When you move, split, or delete the clip on the video track,
the linked audio clip will also be edited with it. This is useful if you've synchronized the clip's audio to the video track and
don't want it to change as you edit your project.

• The linked audio track is hidden at first, until you drag an audio clip between the independent audio track and the video
track.

• You can edit the audio clips' volume and speed in the Tools tab.
• You can have several audio clips playing simultaneously. To do that, simply place them one under the other.

 

Independent audio track
The separate audio track contains audio clips that are not dependent on clips on the video track. This track is good for
background music.

• You can edit the audio clips' volume and speed in the Tools tab.
• You can have several audio clips playing simultaneously. To do that, simply place them one under the other. 

Learn more about audio tracks

Titles track
The titles track contains text clips that will appear on top of all other clips.

• You can change the titles' duration on the Tools tab, or by dragging the edge of the title's clip on the Timeline.

Learn how to place titles
 
Overlay track
The overlay track contains additional video and image clips to create special effects like Picture in Picture or Chroma Key.

• Clips on the overlay track are linked to clips on the video track and will stay in sync as you edit the clips.
• You can apply filters and use all of the Tools to edit the clips on this track, just like any other video or photo.
• You cannot join clips on the overlay track with transitions.

Learn about using overlays
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To select all clips on a single track, click the area with the track's icon to the very left of all clips.
 
Zooming the Timeline
To change the zoom level of the Timeline, drag the Scale slider at the bottom of the window. Move the slider left to zoom out,
and move the slider right to zoom in on the Timeline.

Previewing clips
To preview a clip, click on it on the Timeline. The position marker will move to where you've just clicked, and the current part
of the clip will be shown in the player. Click Play in the player to watch the video.
 
Rearranging clips
By default, media files will appear on the Timeline in the same order in which you've added them. To rearrange the clips,
drag them with your mouse and drop them onto the desired position. To select multiple clips, use Ctrl+click and Shift+click.

Moving the position marker
The position marker defines the currently selected point on the Timeline. There are two position markers: the orange line
on the Timeline, stretching down from the time scale all the way through all of the tracks, and the position marker on the
progress bar of the player. Both denote the current position relative to the whole project and show identical time.
 
The timestamp in the player displays the currently selected time from the beginning of the project.



 

 

 
There are several ways to move the position marker:
 

• Click anywhere on the Timeline to move the position marker to that position.
• Drag the position marker (either on the Timeline, or in the player). For higher precision, try zooming in on the Timeline.
• Press the left or right arrow key to move to the beginning of the previous and next clip, respectively.
• To move in 0.5 second increments, open the Playback menu and choose Skip Forward by 0.5 Seconds or Skip

Backward by 0.5 Seconds.
• To move precisely from frame to frame, use the 'Back' and 'Forward' buttons in the player. This will move the position

marker exactly one frame backward or forward. 

See also:
Audio tracks
Extracting audio from video
 
 



 

 

Working with video and images
After you've added some files to the project, it's time to edit them and create a beautiful video.
Learn how to add media files
 
Using the Timeline
When you add files to your project, they appear on the Timeline in the bottom part of the window. The Timeline allows you to
view the relative length of each clip along a time scale, and make several clips play simultaneously. All videos, pictures and
the transitions between them are located on the video track of the Timeline. To change the order in which they are played,
simply drag-and-drop the clips to the necessary position.
Learn more about the Timeline

 
 
Cut and split video
On the Timeline, select the clip that you want to cut and move the position marker onto the moment where you want to split
the clip. Then, click the scissors button on the toolbar to split the clip into two parts.

If you want to cut out a part of the video, repeat the steps to cut the unwanted fragment at the beginning and at the end,
turning it into a separate clip on the Timeline. Then, select this fragment and press the Delete key on your keyboard. The
unwanted fragment will disappear, and the remaining clips will move up the Timeline to fill in the blank space.
Learn more about cutting videos
 
Add filters



 

 

To apply an artistic filter to your clip, simply open the Filters tab and drag a filter you like onto a clip.
Learn more about filters

 
Picture in picture and overlays
To overlay one video or image on top of another, select the clip you want to show on top and drag it up, towards the top of
the Timeline to create an extra overlay track. Then, double-click the upper clip to set up where the overlay will be shown on
the video.
Learn more about overlays

Picture and picture, side by side overlay modes.
 
Using the editing Tools
The Tools tab also has other tools and special effects that you can use on your videos and images. To use the tools, select a
clip on the Timeline and open the Tools tab. There, click on the tool you need and select the necessary options.
Learn more about Tools



 

 

 



 

 

Cutting video
Using Movavi Video Editor, you can easily split videos into parts and cut out fragments with the Split tool. You can find it on
the toolbar of the main window, marked with a scissors icon: 

Splitting video into parts
1. Select the clip that you want to split.
2. Move the position marker to the moment where you want to cut the clip.
3. Click the Split button on the toolbar.
Note that if the clip has linked audio, the audio clip will also be split.

Cutting out fragments
1. Select the clip you want to cut and move the position marker to the beginning of the unwanted fragment.
2. Click the Split button. The clip will be cut into two parts, with the unwanted fragment at the beginning of the second clip.
3. Select the second clip and move the position marker to the end of the unwanted fragment.
4. Click the Split button again. The fragment is now a separate clip.
5. Select the clip with the unwanted fragment and click the Remove button (trash can icon), or use the Delete key on the
keyboard. The clip will be removed, and the remaining clips on the Timeline will move to close the gap.

For more precise navigation:

• Use the arrow keys to jump to the beginning of the previous or next clip on the Timeline.
• Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to

jump half a second forward or back.
• Use Shift+Ctrl+Left to move the position marker half a second back and Shift+Ctrl+Right to move the marker half a second

forward.
• To move precisely from frame to frame, use the 'Back' and 'Forward' buttons in the player. This will move the position

marker exactly one frame backward or forward. 

using_the_timeline.htm#position_marker


 

 

 



 

 

Applying filters
Using filters you can alter the mood of the video, make an old movie, overlay cool flying objects, and more.
 
Step 1: Open the Filters tab
Click the Filters button to open the filters collection. Click on a filter's thumbnail to see its preview in the player. If you're
looking for a specific filter, you can enter its name into the search box.

Step 2: Apply the filter
When you've found a filter you like, drag its thumbnail onto the clip you want to apply the filter to.

Once you've applied a filter, a star icon will appear on the clip, denoting applied filters and tools.

Clip with an applied filter
Removing filters

To remove a filter, click on the star  icon on the clip to see the list of applied filters and tools. In the list, select the filter that
you don't want and click Remove.



 

 



 

 

Adding overlays
Overlays are video or image clips that are shown over the main video. You can use these to create a split screen or picture
in picture effect, add a logo or watermark, or insert a short clip without cutting the main video.
 
Before you start:
You'll need to add both the main video (the video that will be the bottom layer) and the overlay video or image to your
project. You can use images in PNG format to add transparent logos.
 
Step 1: Place the overlay clip
1. Select the clip that you want to make an overlay and drag it up, towards the top of the Timeline.
2. Drop the clip onto the overlay track, where you want it to be shown relative to the main video track.
Note that a blue line now connects the overlay clip to the main clip. This means that the overlay clip is linked to the main clip:
if you move, cut, or delete the main clip, the overlay clip will also be edited.

Step 2: Edit the overlay
1. Double-click the overlay clip to set it up. An options panel will appear in the player.
2. Open the drop-down box on the overlay panel and choose how you want it to appear on the video: Picture in picture,
Side by side, or Cover.

Picture in picture
This is the default overlay mode. Using picture in picture mode, you can show the overlay video over any part of the screen.
1. Choose Picture in picture mode from the drop-down box.
2. In the player, move the overlay to where you want it to appear in the frame.
3. To resize the overlay, drag at its corners.
4. Deselecting the Constrain proportions option will allow you to resize the overlay to any proportions, but a drastic change
in proportions may make the overlay look distorted.



 

 

Picture in picture overlay
 
Side by side
1. Choose Side by side mode from the drop-down box.

2. Use the buttons on the panel to choose how you want to align the two videos: 

Side by side overlay
Cover
Cover mode can be used for a short insert into the main video without having to cut it. While the main video (and audio!) is
playing, the overlay clip will appear on screen for the duration of the overlay clip.

Cover overlay (the main clip is hidden)
 
Step 3: Apply the changes
After you've set up the overlay, click the Apply button on the overlay options panel.
 
Step 4: Overlay clip tools
You can also edit each overlay clip's speed and opacity. To do that, use the Volume, Speed, and Opacity sliders in the
General section of the Tools tab. Keep in mind that you can also use other clip editing tools on overlay photos and videos!
Learn more about tools
 
 



 

 

Editing tools
The Tools tab allows you to edit the selected clip and add special effects. To use the tools:
 
Step 1: On the Timeline, select the clip that you want to edit. This can be a video or an image clip on any track. Also, you
can edit the volume for audio clips.
 
Step 2: Click the Tools button on the left side of the window to open the Tools tab. Here, you will find the selected clip's
basic properties, such as volume and speed.

Step 3: Choose the tool that you want to use and click on it to see more options.
 
Step 4: Set up the tool however you want to use it. Don't forget to click Apply to keep the changes!
 

After you've used a tool on the clip, it will be marked with a star icon , denoting applied tools or filters.

Removing the changes
On the clip, click the star icon to show the list of applied tools. Then, select the tool you want to discard and click Remove.
Also, you can deselect the tool on the Tools tab.



 

 

General clip properties
At the top of the Tools tab, you can edit the basic clip properties including volume, speed, opacity ands duration.

Volume – can be used to adjust the loudness of video and audio clips. 100% is the original clip's volume.
Speed – can be used to speed up or slow down video and audio clips.
Opacity – can be used to make overlays transparent. Learn about overlays
Duration – can be used to set how long the selected image or titles clip will appear on screen.
Fade in, Fade out – can be used to smoothly fade a video or sound. Learn more

 
Color adjustments
You can use automatic enhancements for your videos and photos, improving contrast, saturation, and white balance. Select
a clip and click the Color Adjustments button on the toolbar to open the enhancement options.
Learn more about enhancements

 
Crop video
When you open the Crop tool or click the Crop button on the toolbar, a frame will appear inside the player. Use this frame to
crop the video and click Apply to accept the changes.
Learn more



 

 

Rotate video and images
Using the Rotate and Flip tool, you can rotate videos by 90°, flip them vertically or horizontally, or apply a cool mirror effect.
Learn more

Zoom
With the Zoom tool, you can create a panning or zooming effect. Choose a zooming mode and then set the zoom target
using the frame in the player and click Apply.
Learn more

Zooming and panning
Chroma key
Using the Chroma key tool, you can remove a color from an entire video and replace the background with any other video
or photo.



 

 

Learn more

Replacing a green background with the Chroma Key effect.
Highlight and conceal
Use this tool to blur or darken a part of the video. This way you can hide certain objects, like license plates or other private
information, or highlight things you want to show!
Learn more

Left to right: no effect, soft focus, conceal.
Stabilizing videos
Use the stabilization tool to remove camera shake from your footage.
Learn more

Before and after stabilizing



 

 

Video volume
This section explains how to manage the volume of video clips. To change the volume of audio clips, refer to the Volume
levels section.
 
Step 1: On the Timeline, select the video that you want to edit.
 
Step 2: Click the Tools button to open the tools for the selected clip.

Step 3: Drag the Volume slider to set the volume for the selected clips.100% is the original volume. To mute the clip, drag
the slider down to 0%.

 
 



 

 

Speed
With the Speed tool, you can speed up or slow down a video or audio clip. This can be useful if you're working on a music
video and you want the video to match the tempo of the music.
 
Step 1: On the Timeline, select the clip you want to edit.

• Note that slowing down videos works best on videos with a frame rate of 60 FPS (frames per second) and above.
• You can also change the speed of any audio clip.
• If you modify the speed of a video with built-in audio, the audio speed will also be changed.

 
Step 2: Click the Tools button to open the editing tools for the selected clip.

Step 3: Drag the Speed slider to set the necessary video speed, where 100% is the video's original speed.

You can see the current length of each slide right under its preview on the storyboard. If you've changed video speed, the
video clips will be marked with a speed icon:



 

 

Changing image duration
By default, all images will be shown for 4 seconds each. To change the duration:

 
Step 1: On the Timeline, select the image clip that you want to edit.
 
Step 2: Click the Tools button to open the tools for the selected clip.

Step 3: In the Duration box, enter the new length of the image. Use the following format: hours:
minutes:seconds.milliseconds. Changes will be applied instantly.

You can also change image duration by selecting an image clip on the Timeline and dragging its borders left or right. The
longer the clip appears on the Timeline, the longer it will play in your movie or slideshow.

 
 



 

 

Fading video and audio
In the editing tools, you can add smooth fades to the beginning or the end of a clip. For videos and images, you can use
fading simultaneously with animated transitions. For audio clips, you can create a smooth crossfade effect between songs.
 
Step 1: On the Timeline, select the clip that you want to fade.
 
Step 2: Open the Tools tab.

Step 3: Set the fade length using the sliders in the General section of the Tools tab

• Fade in – how long in seconds it will take to fade in to full opacity at the beginning of the clip.
• Fade out – how long in seconds it will take to fade out from full opacity at the end of the clip.

 
To create an audio crossfade, add a fade out to the first clip, and a fade in effect to the second clip.

See also:
Adding transitions
 



 

 

Color adjustments
If the original videos look bleak and not vibrant enough, you can use the automatic adjustments to make the colors look
more vivid. If that isn't enough, you can always use manual adjustments to correct the colors.
 
Step 1: Select clip
On the Timeline, select the clip that you want to adjust.
 
Step 2: Open color adjustments
On the toolbar, click the color adjustments button to open the adjustments in the Tools tab.

Step 3: Use auto adjustments
Under Color Adjustments, select the adjustment options that make the selected clip look nicer. The changes will be applied
instantly. The Magic Enhance option will automatically determine the best brightness and contrast balance.

Step 4: (Optional) Use manual adjustments
Click the Manual Adjustments button to show more color control options. Here, drag the sliders to fix the brightness,
saturation, hue, and other properties. To go back to the simple options, click the Auto Adjustments button underneath the
sliders.



 

 

Once you have used the adjustments, the clip will be marked with a star icon, denoting applied tools or filters: 



 

 

Cropping video
Cropping a video can help you remove black bars, cut away the edges of the video, or permanently zoom in onto an object
inside the frame.
 
Step 1: On the Timeline, select the clip you want to crop.
 
Step 2: Click the Crop button on the toolbar. The Crop tool will open in the Tools tab, and a cropping frame will appear
inside the player.

Step 3: In the player, set the frame so that the parts you don't want are outside it.

• Drag by the corners of the frame to change its size.
• Drag by the center of the frame to change its position.
• By default, the frame will have the same proportions as your project. If you want to change the proportions, deselect the

Constrain proportions option. However, note that black bars may appear around the video after if the video's proportions
are different from the project's.

 
Step 4: Click Apply in the Tools tab. A star icon will appear on the clip once you've applied crop.

Removing crop
To remove Crop or any other Tools effect, do any of the following:

•
Click the star  icon on the clip to show the list of applied effects and filters. In the list, select Crop and click the Remove
button to discard the effect.

• In the Tools tab, you'll see a checkmark next to Crop. Click the circle with the checkmark to remove the effect.

 
 
Cropping all clips
Step 1: Open the Edit menu and choose Project Settings to edit your project. The Project Settings window will open.
 
Step 2: In the Resize Method box, choose Crop.



 

 

 
Step 3: Click OK. All the project's clips will be automatically cropped to the project's frame size.



 

 

Rotate and flip clips
Nobody likes vertical videos! But don't worry, in just a few clicks, you can turn any vertically-shot photo or video around
without having to crane your neck.
 
Step 1: Select clip
On the Timeline, select the clip you want to rotate.
 
Step 2: Open rotation tools
Click the Rotate button on the toolbar to open the rotation options in the Tools tab.
 
Step 3: Flip and rotate
Click the arrow buttons to rotate the clip clockwise or counterclockwise or flip it along the horizontal or vertical axis. The
changes will be applied instantly. Here, you can also create a cool mirroring effect.

 



 

 

Zooming clips
Using the Zoom tool, you can draw attention to an object inside the frame by magnifying it, or pan a virtual camera across
the frame.
 
Step 1: On the Timeline, select the clip that you want to zoom.
 
Step 2: Click the Tools tab, scroll the tool list down and click the Zoom tool. The Zoom options will open, and a frame will
appear inside the player. You can use this frame to select which part of the video you want to zoom.

Step 3: On the Tools tab, select the Zoom mode:

• Zoom in-out — the will start at 100%, zooming in on the object, and then zooming back out to 100%.
• Zoom in — the clip will start at 100% and then zoom in on the object until the end of the clip.
• Zoom out — the clip will start already zoomed in, and then slowly zoom out to 100% towards the end of the clip.
• Pan right — this mode uses two frames. The clip will start at the position of the left frame, and then pan to the position of

the right frame.
• Pan down — this mode uses two frames. The clip will start at the position of the upper frame, and then move down, to the

position of the bottom frame.
• Pan and zoom left — this mode uses two frames. The clip will start at 100% (larger frame), and then zoom in to the

smaller frame.

 
Step 4: Set up the zoom level and position using the frames in the player.

• In modes that use one frame, move the frame over the object that you want to zoom.
• In modes with two frames, place the first frame to where you want the clip to start, and the second frame to where you

want the clip to end. During playback, the virtual camera will smoothly move from one frame to the other.



 

 

The size of the frame determines the zoom level, that is, the part of the frame that will be visible at the maximum zoom.
The smaller the frame, the higher the zoom level. If both frames are of the same size, the zoom level will not change. If the
frames have different sizes, the zoom level will smoothly change when moving from one frame to another.
 

Hint:
For best results, use high-definition videos and photos for zooming, since

setting a very high zoom level may lower the quality in zoomed parts.
 
Step 5: In the Zoom section of the Tools tab, click the Apply button. 



 

 

Chroma key
Replacing a video's background

The Chroma key effect allows you to remove any color from the image or video, leaving the background transparent.
 
Step 1: Add the foreground and background clips
Add the video or image clips that you want to use as the foreground and the background. For the foreground (the clip that
you want to remove the background from), use a clip with a bright, solid background that contrasts with the foreground
objects.
 
Step 2: Create an overlay
1. Select the foreground video and move it up, onto the Overlay track.
2. Double-click the foreground video on the Overlay track. The overlay options will appear above the player.
3. To make the foreground video completely cover the background video, select the Cover overlay mode from the list above
the player.
4. Click Apply.

Step 3: Apply Chroma key
1. Select the foreground video on the Overlay track.
2. Open the Tools tab, scroll to the bottom and click the Chroma Key tool to see its options.
3. Once you open the Chroma Key tool, move your mouse cursor over the player and click on the color that you want to
remove. The color you've picked will be made transparent, and the underlying video will now be visible.
Tip: if nothing happens when you click on the player, click the color swatch in the Chroma Key options and then try again.



 

 

4. Use the Tolerance slider to set how many similar shades of the selected color should also be removed. Higher values will
remove similar colors to the one you've selected.
5. Use the Noise level slider to determine how sharp the object's edges should be.
6. Finally, click Apply to accept the changes.

Cropping the video
If the videos you're using for the foreground and background have different aspect ratios, you may end up with black bars
along the edges after applying Chroma key. To fix this, crop the videos to the project's aspect ratio.
How to remove black bars
Cropping videos
 



 

 

Highlight and conceal
Using the Highlight and Conceal tool, you can control the focus in the frame, and blur or darken select parts of the video.
 
Step 1: On the Timeline, select the clip that you want to edit.
 
Step 2: Click the Tools button, scroll down, and click the Highlight and Conceal tool. The tool's options will open, and a
frame will appear in the player.

Step 3: In the Highlight and Conceal tool options, select a mode that suits your needs:

• Conceal — blurs or darkens the area inside the frame.
• Highlight — blurs or darkens the area outside the frame, drawing attention to the object within the frame. 

• Outline — like 'Highlight' mode, the area outside the frame is blurred or darkened, and the frame itself is outlined.
• Soft focus — the edges of the frame are much softer than other modes, simulating a camera's focus.



 

 

Step 4: Choose how you want to highlight or conceal the object: using a rectangle or an ellipse, blurring or darkening. Set
the Transparency level to change the effect intensity.

Step 5: In the player, move the frame over the object that you want to highlight or conceal.

Step 6: On the Tools tab, click Apply under Highlight and Conceal options.



 

 



 

 

Stabilizing video
If you're filming with a handheld camera, it's likely that there might be some unwanted camera shake visible on the video,
especially if you walk or move while filming.
 
Step 1: On the Timeline, select the clip you need to stabilize.
 
Step 2: Open the Tools tab. Scroll down and click the Stabilize tool.

Step 3: Under Stabilize, click Apply to start stabilizing the selected clip. This may take a couple minutes for large clips.

Stabilized copies
A stabilized copy of the file will be created under \My Videos\Movavi Video Suite\Stabilized. This copy will be used in the
project instead of the original video. If you delete the stabilized copy, it will be replaced with the original video, and you will
need to stabilize the clip again.
 
Filming tips:

• When shooting videos, try to rest the camera on something.
• If possible, use a tripod. Some tripods are really small and can fit into your bag.
• If you can't put down the camera, hold it with both hands and close to your body. This will minimize the shaking.
• Try to move around less. If you have to move the camera, do it slowly.
• Check your camera's settings to see if it has built-in stabilization.



 

 

Working with audio
Add audio
You can add audio the same way as you would add video and images: on the Import tab, click the Add Media Files button
under My files and choose the audio files you want to use. If you don't have suitable audio files you can use free music
themes from the Sample audio collection.
Learn more about adding audio

Audio tracks
The Timeline consists of video and audio tracks for each type of media. There are two types of audio track: linked audio and
independent audio.
 
Linked audio clips, located on the upper audio track, allow you to 'attach' sound to a point on a video clip, so that when
you move or split the video, the audio will also be moved and split with the video. This is especially useful if you're adding a
voice-over and want it to stay synchronized to the video throughout the editing process. To link an audio clip to video, drag
an audio clip up towards the video clip you want to attach it to, and align the beginning of the audio with the place on the
video clip when you want the audio to start. A blue line will connect the video clip to its linked audio.
 
Independent audio clips stay on the lowermost audio track, and play independent from any other tracks. For example, you
can place a background music clip on this track, and it will play throughout the project. By default, all new audio files will be
added as independent audio.
Learn more about audio tracks

Extract audio from video
When you add a video to your project, both the video and its soundtrack will be located on the video track. The soundtrack
is shown as a line underneath the video track. To separate the audio from its video clip, drag-and-drop the audio down to the
independent audio track. You've just extracted the soundtrack from a video file! If you don't need the original video, feel free



 

 

to delete it from the timeline by pressing the Delete key on your keyboard. Don't worry, the audio will remain where you've
put it.

Set volume levels
You can set volume levels independently for each video and audio clip.
1. Select the clip that you want to edit.
2. Open the Tools tab.
3. In the General tools, drag the Volume slider to set the necessary volume where 100% is the volume of the original clip.

Split audio
You can cut and split audio clips the same way as you would work with video. To split an audio clip into two parts:
1. Select the audio clip you want to split
2. Move the position marker to where you want to cut the video.
3. Click the Split button (scissors icon) on the toolbar and the audio will be split into two parts.

Loop audio
If the background music ends before your movie does, you can loop the music clip to continue playing until the end:
1. Copy the music clip.



 

 

2. Paste it onto the audio track nearby as many times as necessary, until the music is as long as the video. Make sure that
the clips are aligned side-by-side and do not overlap.
3. Now, the last looped clip is probably longer than the video. To trim it from the end, drag the rightmost edge of the audio
clip to the left, so that the audio clip ends when you want it to.
 



 

 

Adding audio
You can add audio files in much the same way as you add video files.
 
Add files from your hard drive
1. On the Import tab, click Add Media Files to browse for audio files on your computer.
2. A Windows Explorer dialog box will open. Choose the files that you want to use.
3. Click Open. The files will be added onto the audio track of the Timeline.

Use sample audio clips
If you don't have any suitable audio files, you can use free sample audio clips[1] from our audio collection.
1. On the Import tab, click Sample audio to open the free stock audio collection.
2. Click on a clip to play it. When you've picked a clip, drag it onto the audio track of the Timeline.

Record audio
1. Connect a microphone to your computer.
2. On the Timeline, place the position marker to where you want the recording to start.
3. Click the microphone button on the toolbar to open recording options.
4. Set up your recording device and volume.
5. Click Start Recording and record the audio. When you're finished, click Stop Recording. You'll find your new recording
on the Timeline.
Learn more about audio recording



 

 

 
Set start time for audio clips
After you've added the audio files, they will appear on the audio track of the Timeline as a blue line with a music note icon:

By default, the audio clips will be added to the very beginning of the audio track on the Timeline. To change when the audio
clip starts playing, drag it along the Timeline.
Learn about audio tracks
 

[1] Stock Audio Tracks:
Stock audio tracks are copyright of their respective owners and are free for both personal and commercial use with credit
attribution under the Creative Commons license.
Adventure
"Coulda Shoulda Buddha" by UncleBibby
Available on the Free Music Archive
(freemusicarchive.org) Under CC BY license

Mystic
"Lunar Dunes" by Spinning Clocks
Available on the Free Music Archive
(freemusicarchive.org) Under CC BY license

Romantic
 "The Wrong Way" by Jahzzar
Available on the Free Music Archive
(freemusicarchive.org) Under CC BY-SA license

Travel
"Nobody Here But Us Charles Dickens" by UncleBibby
Available on the Free Music Archive
(freemusicarchive.org) Under CC BY license

 

http://creativecommons.org/licenses/by/3.0/
http://creativecommons.org/licenses/by/3.0/
http://creativecommons.org/licenses/by/3.0/
http://creativecommons.org/licenses/by/3.0/
http://creativecommons.org/licenses/by/3.0/


 

 

Audio tracks
When you add new audio files, they will be added to the audio track of the Timeline.

Audio clip on the Timeline
There are two kinds of audio track: independent audio track and linked audio track.

Independent audio
The bottom audio track is the independent audio track. Audio clips on this audio track will play independent of any other
clips, which is perfect for background music. By default, all newly added audio clips appear on the independent audio track.
 
Linked audio
The linked audio track appears when you attach an audio clip to a video clip. Linking an audio clip to a video means that the
audio clip will always be synchronized with this video clip, as if it was part of the video file. This is especially useful if you
want to add a voice-over and make sure it stays synchronized with the video as you continue working on the project.
 

• Linked audio can be 'attached' to any point of a video clip, whenever you want the audio to start.
• If the linked audio is longer than the video it is attached to, it will keep playing when the video clip ends.
• If you move the video clip, its linked audio clips will also be moved, without losing sync with the video.
• If you delete the video clip, the linked audio clips will also be deleted.
• If you split the video clip, the linked audio clip will also be split into two parts, each linked to the same points of the video

as they were before.

 
To link an audio clip:
1. Drag the audio clip up, towards the video track. The linked audio track will appear – this is where you will need to place
the audio clip.
2. A blue line will appear, connecting the beginning of the audio clip to a point on the video clip. This line marks when the
audio clip will start playing relative to the video clip. Drop the audio clip onto the linked audio track, so that the blue line is at
the point when you want the audio to start.



 

 

Drag the clip up to attach it to a video.
Embedded audio on the video track
Video clips are usually made up of video and audio streams. When you add a video to the Timeline, it will be added to the
video track as a video clip with an audio clip underneath it. Whenever you move or split a video, its audio will also be moved
and split with the video.
 
If you want to edit the video's soundtrack separately, you can detach it from the video clip: drag the audio clip from
underneath the video down onto the independent audio track.

 
 
 
 
Playing audio synchronously
If you want two audio clips to play at the same time, simply drag one clip underneath the other. This way, you can have
as many sub-tracks as you want. With music, you can use this to create a crossfade effect when you join songs: align the
beginning of the second song with the end of the first song to make them joined almost seamlessly.

The end of the first audio clip will be played with the beginning of the second clip.



 

 

Problem: My audio clip appears on the video track
Solution: Some audio files contain album art, which may sometimes be recognized as the video stream. Therefore, these
files may be placed on the audio track. In that case, drag the audio clip down onto the audio track, and delete the album art
from the video track if you do not need it.
 
 



 

 

Volume levels
Changing volume levels works the same way for video and audio clips:
 
Step 1: On the Timeline, select the clip that you want to edit. This can be a video or an audio clip on any track.
 
Step 2: Click the Tools button to open the tools for the selected clip.

Step 3: Drag the Volume slider to set the necessary level, where 100% is the original volume. To mute the clip, drag the
slider down to 0%.

Playback volume
Only for previewing
If you need to temporarily change the volume of playback in the editor, without changing the project's volume, click the
speaker icon in the preview area and set the necessary volume level. Please note that this will only affect the volume while
previewing the project in Movavi Video Editor, and will not affect the output file.



 

 

Cutting audio
Splitting audio
1. Select the clip that you want to split.
2. Move the position marker to the point where you want to split the clip.
3. Click the Split button on the toolbar (scissors icon).
The audio clip will now be split into two parts.

Trimming audio
To trim an audio clip from the beginning or from the end, hold your mouse pointer over the left or right edge of the clip and
drag it towards the center. The length of the audio clip on the Timeline reflects the length of the sound.

Cutting out parts
Let's say you want to cut out a fragment from the middle of an audio clip. This is done the same way as splitting video and
audio, except that you will need to split the clip twice.
 
1. Split the audio clip at the beginning of the unwanted fragment. To do that:

1.1 Select the clip you want to cut.
1.2 Find the beginning of the unwanted fragment and move the position marker there.
1.3 Click the Split button on the toolbar (scissors icon).

This will split the clip into two parts, with the unwanted fragment located in the beginning of the second clip.
 
2. Split the audio clip at the end of the unwanted fragment. To do that:

2.1 Select the second clip.
2.2 Find the end of the unwanted fragment and move the position marker there. 
2.3  Click the Split button again.

The fragment is now located in a separate clip.
 
3. Now, select the clip with the unwanted fragment and press the Delete key on your keyboard. The clip will be removed,
and the remaining clips will be moved up to close the gap.

For more precise navigation:

• Use the arrow keys to jump to the beginning of the previous or next clip on the Timeline.
• Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to

jump half a second forward or back.
• Use Shift+Ctrl+Left to move the position marker half a second back and Shift+Ctrl+Right to move the marker half a second

forward.
• To move even more precisely, use the 'Back' and 'Forward' buttons in the player.



 

 



 

 

Looping audio
If the music file you've selected doesn't go all the way until the end of your movie, you can loop the audio and have the file
play over again until the end of the video.
 
1. Copy the audio clip. To do that, right-click the audio clip on the Timeline, and choose Copy from the pop-up menu, or use
the Ctrl+C keys.
 
2. Paste the audio clip onto the Timeline right next to the first clip. The clip will be inserted right after the position marker.
Repeat until the audio is as long as the video.
 
3. Now, the audio track may be longer than the video track. To trim the audio, hold your mouse pointer over the right edge of
the clip, and drag the edge to the left, until the end of the audio clip is right under the end of the video clip.

 



 

 

Extracting audio from videos
If you want to use a soundtrack from a movie, you can extract it from a video file and use it in your project. 
 
Step 1: Open video file
On the Import tab, click Add Media Files and choose the video that contains the music you want. The file will be added to
the video track of the Timeline.

Step 2: Trim video
If you don't need the whole video's soundtrack, you can trim away the parts of the video you won't need. It's easier to do this
with the video file, as the video can help you visually find the beginning and end of the fragment you need.
1. Select the video you want to trim.
2. Move the position marker to the beginning of the fragment you want to keep and click the Split button on the toolbar
(scissors). You've just cut off the beginning of the video. 
3. Now, select the second clip and move the position marker to the end of the fragment you need. Click the Split button
again, and the fragment will now be in a separate clip.
4. If you don't need the other fragments, select them on the Timeline and click the trash can button on the toolbar to delete
them.

Step 3: Extract the video
The audio that belongs to a video is shown right underneath it on the video track. To separate it from the video, drag the
audio stripe down onto the audio track. If you don't need the video clip anymore, go ahead and delete it.



 

 

You can now work on the extracted audio clip.
 
Step 4: Save the audio (optional)
If you want to save the audio clip for later use, you can export it as an audio file:
1. Click the Export button. The export window will open.
2. In the Export window, switch to the Save Only Audio tab.
3. Select an audio format that you want to save the audio file in.
4. The Save to field shows where on the disk the file will be saved. To change that folder, click Browse and select a new
folder.
5. Finally, click Start to save the audio file.
 

Please respect copyright laws and stay within the boundaries of fair use of copyrighted materials.



 

 

Adding titles
Adding text titles to your movie allows you to express your thoughts and supplement the audio with subtitles.
 
Step 1: Go to the Titles tab
On the left-hand side of the window, click the Titles button to view the titles collection. Click on a title style's thumbnail to
preview its looks in the player and choose the titles you want to use.

Step 2: Add a titles clip
To add titles to your project, pick a title style you like and drag its thumbnail onto the title track of the Timeline, right above
the video track. A title track will appear above the video track: drop the titles here, onto the time where you want them to
appear. The titles will appear as a purple ribbon on the Timeline.
 
The beginning of each title clip is linked to a corresponding video clip on the video track. This way, whenever you move or
edit the video clip, its titles will always stay in sync.

If you already have a titles clip on the Timeline, you can add another clip onto the same timeframe to make them play
simultaneously: simply place one title clip under another.
 
Step 3: Edit titles
When you've added a title clip, it will start out with the default text and looks. Double-click the title's ribbon on the Timeline to
show editing options in the player.
 
Title clip properties



 

 

Click the cogwheel icon  at the top of the editing panel to see title clip properties. Here, you can change the duration of
the titles and animation speed (how fast they will appear or disappear).
 
Editing text
1. In the preview, double-click on the text box you want to edit. 
 
2. Enter the new text.

3. Click the Font properties  button and select the font style, size, and alignment options for the selected text.

4. Click the Color properties  button and choose a color for the text, and the outline's width and color.
 
5. Drag the text box to where you want to see it on the video.
 
Editing decoration elements
Some titles come with frames, ribbons, and other decorations. To change their color, select the decoration element you want

to edit and click the Color properties  button. Then, click the Decorations color palette and choose the new color.
 
Finally, click Apply to exit editing mode.



 

 

Adding transitions
Transitions are short animations that use geometric shapes and transparency to connect two clips in a creative way.
 
Add a transition
1. Click the Transitions button in the upper left-hand corner of the window to open the list of all transitions.

2. In the list of transitions, pick a style you like and drag-and-drop its icon between two clips on the Timeline.

A transition icon will appear between the two clips.

Change transition length
By default, each transition will be set at 2 seconds long. To change the transition length:



 

 

 
1. Double-click a transition on the Timeline to open transition properties.
 
2. In the Transition Properties window, enter the new transition length in the Duration field. The format is
hours:minutes:seconds:milliseconds. If you want all transitions that are currently in the project to have the same length,
select the Set this duration for all transitions option.
 
3. Click OK to apply the changes.

 
Add transitions to all clips
You can automatically add transitions between all clips in your movie in just a few steps:
1. Click the slideshow button on the toolbar. The Create Slideshow dialog box will open.
2. In the Create Slideshow dialog box, select a transition style that you want to use for all clips. If you want to use different
transitions, use the Random Transitions option in the list of transitions.
3. In the Transition duration box, enter the length that you want to set for all transitions. A transition cannot be longer than
the shortest clip in your project.
4. Click OK to accept the changes.
Creating Slideshows

Remove a transition
To remove a transition from your movie or slideshow, right-click the transition on the Timeline and choose Remove
Transition from the pop-up menu. If you want to delete all the transitions in your project, choose Remove All Transitions.



 

 



 

 

Creating slideshows
With Movavi Video Editor, you can easily create a slideshow in just a few simple steps:
 
Step 1: Open the Video Editor
Open Movavi Video Suite and click Edit video in the Video tab to launch the video editing module.

Step 2: Add videos and photos
On the Import tab, click Add Folder in the My files section to add the contents of an entire folder (for example, all your
vacation photos!) or click Add Media Files to add individual files.
Adding media files

Step 3: Add transitions and set slide duration
Now that you've added the media files, they will appear on the Timeline. Now it's time to set the length of each slide and join
them with interesting transitions.
 
1. Click the slideshow button on the toolbar.
 
2. In the Create Slideshow dialog box, select a transition style that you want to use for the slideshow. If you want to use
different transitions, choose the Random Transitions option.
 



 

 

3. In the Image slide duration field, enter how long you want each slide to be shown on screen. The format is
hours:minutes:seconds:milliseconds for both transitions and slides.
 
4. In the Transition duration field, enter the length for all transitions. Transition length cannot exceed slide length.
 
5. Click OK to accept the changes and add the transitions.
 
If you want to change individual transitions, go to the Transitions tab and drag the transition you want in between two clips
on the Timeline.
Learn more about transitions

Step 4: Add background music
To add music, go back to the Import tab and click the Add Media Files button to choose a background audio file. If you
don't have suitable audio files on your computer, you can use one of our sample music tracks: simply click Add Sample
Audio and select the music you want to use. The selected audio clip will be added to the audio track of the Timeline.
Learn more about adding audio
Learn more about working with audio
 
Step 5: Add titles
To add text to your slideshow:
1. Go to the Titles tab.
2. Drag a text style you like onto the top of the Timeline and drop it onto the titles track.
3. Double-click the titles ribbon to edit the clip.
4. In the player, enter your text and set up the font and color options.
5. Click Apply on the options panel to accept the changes.
Learn more about adding titles



 

 

Step 6: Save your slideshow
Finally, it's time to save your slideshow.
1. Click the Export button in the bottom right-hand corner of the window.

2. In the Save as Video tab of the Export window, choose the format that you want to save the video in. This will affect
video quality and file size.
3. The Save to box shows where the video file will be saved to. If you want to choose a different location, click Browse.
After that, name your slideshow in the File Name box.
4. Click Start to begin processing your slideshow! This may take up to a few minutes, depending on the size of your
slideshow.



 

 



 

 

How to get rid of black bars
Sometimes, when you use videos of different aspect ratios, or if the project is set up incorrectly, some videos may have black
bars around them. This can be fixed by adjusting the project settings, so that they fill up the whole frame.

 
Some clips have black bars around them
If some videos or photos have black bars around them, it is most likely that they have a different aspect ratio from that
defined in the project settings. For example, even videos and photos shot with the same camera may differ in width and
height, so that when you place them side by side, one of them may end up with black bars. To fix this, you can crop away the
edges of those clips, so that they fill the entire frame:
 
1. Beneath the Timeline, find the Project settings information and click the pencil icon next to it to open the project settings
window.

2. Open the Resize Method box and select Crop from the list.
3. Click OK.



 

 

All clips have black bars around them
If all of the clips have black bars around them, then it's a good idea to change the aspect ratio of the project to match that of
the clips you are using.
 
1. First, you'll need to find out the size of the videos you are using, so that you can match it in project settings. To do that,
right-click a clip on the Timeline and choose File Information from the pop-up menu. Here, note the width x height size of
the frame (e.g. 1920x1080) and the aspect ratio (e.g. 16:9).

Now we'll need to set the project settings to the same frame size.
 
2. Beneath the Timeline, find the Project settings information and click the pencil icon next to it to open the project settings
window.



 

 

3. Under Frame Size, choose the frame size with the same aspect ratio as your videos. If you can't find it in the list, you can
manually input the frame size into the boxes below.
 
4. Click OK to accept the changes. The clips should now nicely fit inside the frame without any black bars.

 



 

 

Exporting videos
When you're done with your project, you'll need to export it as a media file to be able to play it back in media players, mobile
devices, and so on. This section will guide you through the process of exporting your project to a popular video format. If you
want to find out more about other ways of saving videos, see the following guides:
Saving only audio
Saving videos for devices
Saving videos for uploading online
 
Step 1: Open the Export window
To start saving the video, click the Export button in the bottom right-hand corner of the Editor. The export settings window
will open.

Step 2: Choose a format
Open the list at the top of the window and choose a format for saving the video in.  Some formats allow you to choose which
video codec you want to use, and some allow you to save 60 FPS video*.
*The video file will have a frame rate of 60 FPS only if the original video files used in the projects had a frame rate of 60 FPS
and above.
 
If you don't know which format to choose, try using MP4 with the H.264 codec. The MP4 format is supported by most
platforms and operating systems.

Step 3: Check your project settings
When saving standard video, the video will be exported with the same settings that were set for the project. This way, the
output video will appear exactly as you have seen it in the preview area. If you want to change the resolution, aspect ratio, or

other settings, click the pencil icon  to view and edit the project settings.



 

 

 
The Estimated File Size field shows how much disc space your file will require after saving. If the file size is too large, you
can set a lower resolution in the Project Settings. At lower resolutions, the file will be significantly smaller, however, the video
will lose some quality due to the limitations of digital data compression. When changing resolutions, we recommend that you
keep the same aspect ratio to avoid black bars around the video or other unwanted distortions.
Learn more about project settings

Step 4: Select quality (optional)
If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a
higher bitrate. This will increase the output file size but will preserve better quality. For most other projects, Good quality will
provide a nice result at a small file size.
 
Step 4: Choose a destination folder
Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving
output videos specified in the preferences. To set a different folder, click the Browse button and choose the folder in the
Windows Explorer window, or enter the path manually into the box. Name your video in the File Name field: the project's
name will be filled in for you by default.

Step 5: Start exporting
Click the Start button to begin processing the video file. This may take up to a few minutes.



 

 



 

 

Export only audio
This section will guide you through exporting just the audio track of your project.
 
Step 1: Click the Export button in the bottom right-hand corner of the Editor to open the export settings window.

Step 2: At the top of the Export window you will find a number of tabs. Click on the Save Only Audio tab

Step 3: Open the list at the top of the tab and select the format you'd like to save the audio in.
 
While MP3 is the most commonplace format, supported by almost all media players and devices, FLAC format allows you to
preserve high audio quality, albeit taking up considerably more disc space. When choosing an output format, it is important
to note the quality of the original files: due to data compression limitations, digital audio cannot be restructured from very low
quality files by saving them as FLAC audio, and vice versa – high quality files may lose some of that quality when saved to
MP3 format which is limited to 320 Kbps.
 
When saving audio from your project, the audio file will retain the same sample rate and channel settings as you have set for
your project. The audio bitrate will be determined from the quality of the original files and from the maximum bitrate for the
selected format (for example, MP3 is limited to 320 Kbps, while FLAC bitrate is not limited).
 
Step 4: Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving
output videos specified in the preferences. To set a different folder, click the Browse button and choose the folder in the
Windows Explorer window, or enter the path manually into the box. Name your video in the File Name field: the project's
name will be filled in for you by default.
 



 

 

Step 5: Click the Start button to begin processing the video file. This may take up to a few minutes. 



 

 

Export for devices
This guide will help you export your video project for playing on mobile phones, tablets, TVs, and other devices.
 
Step 1: In the bottom right hand corner of the Editor, click the Export button to open the export settings window.

Step 2: At the top of the Export window, you will find a number of tabs for saving different kinds of media. Choose the
necessary tab depending on your type of device:

• For Apple Devices: to save the video for devices made by Apple, including iPhones, iPads, iPods and Apple TV.
• For Android Devices: to save the video for smartphones, tablets, and other devices running the Android operating

system.
• For Other Devices: to save the video for devices running neither iOS nor Android. These include Blackberry and Nokia

smartphones, classic mobile phones with 3GP and 3G2 video, Xbox, PlayStation, Zune, and others.

Step 3: Once you've opened the necessary tab, open the list at the top and select your device or manufacturer from the list.
 
Note the Export Settings information, where you can view the properties for the output file. Due to the limitations of some
devices, the video resolution, audio quality, and other properties may be changed to adhere to the requirements of the
selected device. Estimated File Size will give you a rough estimate of how much disk space the file will occupy, which may
be important if your device is running out of memory.
 
Step 4: Set export quality (optional).



 

 

If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a
higher bitrate. This will increase the output file size but will preserve better quality. For most other projects, Good quality will
provide a nice result at a small file size.
 
Step 5: Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving
output videos specified in the preferences. To set a different folder, click the Browse button and choose the folder in the
Windows Explorer window, or enter the path manually into the box. Name your video in the File Name field: the project's
name will be filled in for you by default.
 
Step 6: Click the Start button to begin processing the video file. This may take up to a few minutes.



 

 

Export online
When exporting your video project, you can prepare it for uploading to YouTube and other video hosting sites.
 
Step 1: When your project is complete, click the Export button in the bottom right hand corner of the Editor to open the
exporting window.

Step 2: The upper part of the Export window contains a row of tabs. Click For Uploading Online to open the list of relevant
settings.
 

Step 3: Open the list at the top of the tab and choose a suitable format for saving your video.
 
For YouTube and other video sharing websites:
If you want to upload the video to a video hosting website, such as YouTube, you can simply choose one of the available
presets, such as YouTube - 720p. For some, you can choose to save the video in a variety of resolutions: for example,
you can choose HD or standard-definition video. However, if the original videos are of HD quality, we recommend that you
choose a higher resolution, as the video sharing service will automatically create a lower-resolution copy of your video for
low-bandwidth viewers.
 
Please note that some video sharing websites limit HD video uploads for different types of accounts. We advise you to check
the website's upload restrictions, as well as any copyright policies, and to make sure that you have the right to publish the
videos in question under copyright laws and your country's law.
YouTube Help – Increasing your upload limit
 
For your own website or web storage:

https://support.google.com/youtube/answer/71673?hl=en
http://vimeo.com/help/faq


 

 

At the bottom of the list, you can find a number of web-ready formats. Choose the one that best fits your upload
requirements. You can also embed YouTube videos into your blog or website: simply save your video using one of the
YouTube options, upload the video to your YouTube account, go to your video's page and then click Share, and go to the
Embed tab. YouTube will give you an HTML5 embed link for your video that you can use in your website or blog.
 
Note the Export Settings section, where you can see the properties that your output video will be saved with. These
properties are defined by the selected format, resolution, or the requirements of the chosen video sharing website.
 
Step 4: Select video quality (optional).
If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a
higher bitrate. This will increase the output file size but will preserve better quality. For most other projects, Good quality will
provide a nice result at a small file size.
 
Step 5: Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving
output videos specified in the preferences. To set a different folder, click the Browse button and choose the folder in the
Windows Explorer window, or enter the path manually into the box. Name your video in the File Name field: the project's
name will be filled in for you by default.
 
Step 6: Click the Start button to begin processing the video file. This may take up to a few minutes.



 

 

Saving and opening projects
A project stores all the work on your movie or slideshow. You can save the project for finishing your work later, or restore
your work if you need to edit something after you've finished.
 
Saving the project
1. Open the File menu and choose Save Project.
2. You will be asked to enter a name for the project. Your project files should be stored in the Movavi Video Suite folder of
your user. 
3. Click Save to confirm saving.

Later, you can open this project to continue working on your project.
 
Opening a project
1. Open the File menu and choose Open Project.
2. Locate the project file.
3. Click Open in the dialog box.
 
You can now resume your work on the project.
 

See also:
Finding missing files
Project settings
Exporting videos
 
 
 
 



 

 

Finding missing files
When you open a previously created project, you may see a message saying that a file is missing from the project. This may
happen if one of the files used in the project has been moved somewhere else or deleted from disk. 

 

• If the file was moved elsewhere, click the Browse button and locate the file in the Windows Explorer window. After that,
you can continue working on the project as usual: the file will be restored in its place on the timeline, as well as any other
changes you have made.

• If the file was deleted or you no longer wish to use it in the project, click Skip to open the project without the missing file.
• To cancel loading the project, click Cancel.

 

Why is this happening?
In order to save disk space, the program does not copy the files you add to the project, but rather remembers their location
on disk. Therefore, if you move or delete the original files, it will no longer be able to use them as reference.
 



 

 

Project settings
You can set up your project's video and audio settings both when creating the project and at any other time.
 
Opening Project Settings
When creating a project:
When you create a new project or launch Movavi Video Editor, you will see a small window where you can choose an aspect
ratio for your project. Click Advanced Settings to show more video and audio settings.
 

During editing:

• On the bottom panel, find the pencil icon next to the information about your project. 
• Open the Edit menu and choose Project Settings.

The Project Settings window will open.

Video Settings
The video settings apply to all videos and photos used in the project. When you import the media files, they will be scaled to
fit inside the selected frame size according to your settings. 
 
Frame size
The frame size or resolution determines the videos width and height in pixels. Open the Frame Size list to select from the
most common resolutions. For your convenience, each resolution is marked with its respective aspect ratio. Ideally, the
frame size should match the resolution of the videos and photos you plan to use in your project, and should not exceed
the resolution of the largest video. Smaller resolutions allow you to make the output video smaller and thus save your disc
space, however, this will sacrifice some video quality due to downscaling.

Frame Size Aspect Ratio



 

 

320x240 4:3
640x480 4:3

1280x720 16:9

1280x960 4:3
1920x1080 16:9
1920x1440 4:3

Aspect ratio
The aspect ratio is the ratio of the video or photo's width to its height. The most commonly used aspect ratios are 4:3, used
generally for analog TV and in many old movies, and 16:9, the standard resolution for widescreen digital video.

A relative comparison of aspect ratios
 

When you add videos and photos to the project, they will be scaled to fit the specified frame size. If you add media files with
an aspect ratio different from that of the project, you may see black bars appear on the sides of the video. Furthermore, if
you add low-quality videos to a project set up to a high resolution (frame size), the small video may be stretched to fit the
frame and thus may appear pixellized. For best results, we recommend setting the frame size and aspect ratio to match all
or most of the videos and photos you are planning to use.

 
Examples of black bars appearing when importing videos with a different aspect ratio.

 
If you cannot find the necessary frame size in the list, you can manually enter the width and height into the respective boxes
of the Project Settings window. Note the button with the link icon to the right of the boxes. It allows you to maintain existing

proportions when entering new values:   – the proportions are constrained, allowing you to set a larger or smaller frame

size without changing the aspect ratio;  – you can freely enter the width and height with any proportions. Simply click this
button to toggle the two states.
 
Resize method
Choosing a resize method can help you manage how all of your videos and photos are resized to fit inside the frame size
you've set. This is especially important when the aspect ratio of some videos and photos does not match the aspect ratio of
the project and you need to get rid of the black bars. There are three resizing options available:
 
Letterbox – the video will be resized to fit inside the frame entirely. This method allows you to keep the whole video inside
the frame without distortions, but may place black bars around the video.



 

 

Stretch – the video is fit entirely inside the frame and then stretched on one axis in such a way as to fill the entire frame
without leaving black bars. This allows you to cover the entire frame, however, the objects in the video may appear
horizontally or vertically distorted.

Crop – the video will be resized to be slightly larger than the frame, cropping the parts that do not fit inside it. This allows
to cover the entire area of the frame without distorting any of the objects inside the video or without leaving black bars,
however, this may not suit some clips where important objects are near the edge of the frame.

Audio Settings
Sample rate
The sample rate affects the quality of digital sound, and defines the maximum frequencies that an audio stream can contain.
The default sample rate is set to 44100 Hz, which exceeds the maximum frequencies of human hearing and is used to
record Audio CDs and most music tracks.
 
Channels
Stereo sound contains two channels and has the capacity to convey the relative location of sound sources, which makes
it best for recording music; mono sound has only one channel and produces sound without differentiating left and right
channels. Stereo is the generally preferred number of channels, however, some mobile devices record sound only in mono
mode.
 
File properties
To open a file's properties, right-click or Ctrl+click it on the storyboard and choose File Information from the context menu.
Knowing certain information about a clip will allow you to better understand which settings are best for your videos.



 

 

A small File Information window will appear. Here, you can find out the video or image's resolution, aspect ratio, and
other properties.

See also:
Creating a project
Saving and opening projects
 
 
 



 

 

Editor preferences

To open the preferences, open the Settings menu and select Preferences.
 

Interface Language – to change the interface language, simply select the necessary language from the list and click OK to
apply the changes.
 
Directory for project files – this folder will by offered by default when saving and opening projects. This folder will also
store any autosave files for new projects. You can use the autosave file to restore your work in case of an error or force
close.
 
Directory for saving output videos – this folder will be offered by default when exporting media files.
 
Directory for audio recordings – the audio clips that you record in the Editor will be stored as audio files in this folder. Tip:
if you delete these audio files, the audio recordings in the project will also be unavailable.
 
Directory for stabilized files – when you stabilize a video, a stabilized copy of the original will be created in this folder and
used instead of the original. Tip: don't delete these files while you are working on the project, or you'll have to stabilize the
files again.
 
Automatically check for updates – select this option and you'll be notified whenever a new version is available. Updates
within your version are absolutely free (e.g. 1.0 to 1.1), while new releases are offered with a hefty discount to registered
users.
 
Send anonymous usage stats to Movavi – checking this box will allow the program to send usage statistics to our
development team, enabling us to fix any bugs you may encounter much faster, as well as add new features that you might
be missing. The data sent by Movavi Video Converter contains no personal information, will not be disclosed to third parties
and will be used for software improvement purposes only.
Learn more about how we use the statistics
Read our Privacy Policy
 
Show project settings window when creating new project – with this option enabled, you will be prompted to select
settings for the new project on startup and when creating new projects. You can choose the project's aspect ratio and other
settings, as well as open an existing project.
 
Enable Intel® hardware acceleration – if this option is available, your computer is equipped with an Intel HD Graphics™
chip. Enabling this option will allow using this graphic chip during exporting to accelerate video processing by up to 400%.
Learn more
 
When you're done, click OK to close the window and apply the preferences.
 
 

http://www.movavi.com/mip.html
http://www.movavi.com/privacy.html


 

 

Convert files
Using the Converter application, you can change the format of video, audio and image files, convert files to play on devices
or prepare files for uploading online.

What can I do with the converter?
Convert video files to a different format
Convert videos for watching on devices

Convert videos for uploading online
Convert audio files

Change image format
Create a GIF from a video

 
How to use the converter?

Step 1: Open the Converter app Step 2: Add files
Use the buttons at the top to open

the files you want to convert.
Step 3: Choose an output format

Select the format you want to convert the files to.
Step 4: Edit and choose conversion options

Make changes to the files before conversion.
Audio tracks

Subtitle tracks
Reduce size

Step 4: Choose the output folder
Select the folder where the newly
converted videos will be stored.

Step 5: Convert!
Click the Convert button to start processing the files.



 

 

Open the converter
To open the conversion app:
 
In the Movavi Video Suite launcher, click Convert video on the Video tab.

In the Movavi Video Suite launcher, click Convert audio on the Audio tab.

In the Movavi Video Suite launcher, click Convert images on the Photo tab.



 

 



 

 

Convert video
Converting media files

Step 1: Open the converter app
In the Movavi Video Suite launcher, click Convert video in the Video tab. The Movavi Video Converter application will open.

Step 2: Add media files
First, open the files you want to convert.
1. Click one of the buttons at the top to add files in that format.
2. In the Windows Explorer dialog box, select the necessary files and click Open. After the files have been added, you will
see them in the file list.
Learn more about adding media files

Step 3: Choose a preset
Next, choose the format you want to convert the files to. A preset is a set of media properties that we've put together for
each format, that is designed to work well for most files. This way, when you select a preset, you don't have to worry about
defining the bitrate and other properties, because the optimal values have already been automatically selected for you.
 



 

 

1. At the bottom of the window, click the 'Convert to' field to open the list of available presets.

2. The presets are organized by file format. Click the category you need to open a list of the relevant formats. For example, if
you want to convert videos to AVI, you'll need to click Video and audio.

3. Find the format you need and click on it to see the available presets. Finally, click on your choice of preset to select it. All
the files in the list are now set to convert using this preset.
Learn more about choosing a preset
 
SuperSpeed
SuperSpeed is a quick conversion mode that lets you convert compatible formats up to 51x faster. Look for the SuperSpeed
icon when you select a conversion preset for superfast conversion.
Learn more about SuperSpeed mode
 



 

 

Step 4: (optional) Edit files
With Movavi Video Converter, you can do some basic video editing. The editing options are located on the panel below the
file list.
1. Select the file you want to edit.
2. On the editing panel, click one of the editing buttons to open related options.
3. Make the necessary changes and click Apply.
The file's thumbnail will now be marked with a star icon, showing that some changes have been made.

Learn more about editing:
Trim video and audio     Join files     Flip and rotate videos     Add a watermark     Adjust colors     Enhance audio

 
Step 5: Choose your output folder
At the bottom of the window, note the Destination field. This shows the path to the folder where the newly converted files
will be saved. To change the destination, click Browse and select a different folder (or create a new one).
Learn more



 

 

Step 6: Convert!
Finally, click Convert to start processing the files. This may take anywhere from few seconds to a few hours, depending on
the size and number of files in the list.



 

 

Choose an output format
How do you choose a format for your videos? This will depend on several things, including what you want to convert the
video for, and where you're planning to watch it.

 
General purpose video
If you need an all-round video format that will likely play anywhere, we recommend the MP4 format with the H.264 video
codec. The H.264 codec has a very good quality-to-file-size ratio, and is supported on most platforms and newer mobile
devices.
 
Watching on a mobile device
If you want to watch the video on a mobile phone, tablet, or other portable device, it is important that the format of the video
is supported by your device, and the file size is small enough to fit in your device's storage. With Movavi Video Converter, all
you need to do is find your device in the Devices category; and all the required settings will be selected automatically.
Learn how to convert for mobile devices
 
For uploading to the web
Video hosting sites often have specific requirements for the format and resolution of uploaded videos. To convert for a
specific social network or website, all you need to do is choose the preset for the selected website in the Online Video
group.
Learn about converting videos for the web

 
Faster conversion
If you want the video to convert as quickly as possible, select one of the presets marked with the green SuperSpeed icon:

. These videos will convert up to 51 times faster, and you will not lose any quality in the process.
SuperSpeed conversion only works with compatible presets and will not affect output file size.
Learn how you can convert files faster
 
Reduce file size
If you need to reduce the size of the output file and don't mind sacrificing a little quality, you have two options:

• Select a preset with a lower resolution than that of the original.
• Reduce the bitrate of the video.

Learn more about reducing file size
 

Selecting the format
When you've decided which format you want to use, click the 'Convert to' box at the bottom and select the desired format
from the list of formats and presets.
How to change output file format



 

 



 

 

Convert for devices
Each device has specific requirements to the type of video it can play, with some older devices supporting only a handful of
video formats. To make sure you'll be able to watch the videos on your device, convert them using the output preset* created
specifically for your device, and all the necessary output settings will be selected automatically. This way, you don't have to
look for what formats your phone supports, as it's all selected for you.
 
Step 1: Add files
Open the files you want to convert.
 
Step 2: Open the preset list
Click the 'Convert to' box at the bottom of the window to open the list of presets.

Step 3: Go to device presets
At the top of the preset list, click Devices.

Step 4: Find your brand



 

 

In the Devices list, find the device's manufacturer and click on it.
If you don't see the device's brand in the list, try the search bar, or use a general category, such as Android or TVs.
 
Step 5: Find your device
Choose your device from the selected brand's list and click on it to select it as the output format. Now, the format, codec, and
resolution is automatically selected to match that of your device.

For example, to convert videos for the iPhone 5c, find Apple in the list, and then choose the iPhone 5c preset.
Step 6: Convert
Click Browse to select where you want to save the videos, and then click Convert to start processing the files.

After the videos are ready, all you need is to upload them to the device.
 

* A preset is a pre-made configuration for a specific device that contains all necessary media properties required by this
device.



 

 

Convert videos for the Internet
To upload a video online, whether to a personal website or to a video hosting service, you will need to do two things: convert
it into a suitable format and upload it onto the web.
 
Step 1: Open videos
Click Add Video or Add DVD to add videos to the file list.
Learn more

 
Step 2: Choose a web preset
Click the 'Convert to' box  to open the list of presets, and then click Video and audio at the top of the list. You will see a list
of preset groups. Click on a group to see the related presets, and click on a preset to select it for the output files.

For social networks
To convert videos for a social network or video hosting site, select a preset from the Online Video group. If you're not sure
which website is best for uploading videos, you can consult our comparison page.

For blogs and websites
If you want to embed the video into your own website or blog, select one of the presets from the Web-Compatible Video
group. These formats are optimized for streaming video and are supported by most web browsers.

glossary.htm#preset
http://www.movavi.com/support/how-to/where-to-upload-video.html


 

 

 
Step 3: Choose a Destination Folder and Convert
Make sure that the Destination line shows the correct folder. If not, click Browse and specify the folder to store your videos
in. Once you're ready, click Convert to start the video processing. When your videos are ready, all that's left is to either
upload them to the video hosting service you prefer, or upload them to your website's server and create a link to your video.



 

 

Change the aspect ratio
What is aspect ratio?
A video's aspect ratio is the ratio between its width and height. The two most commonly used aspect ratios are 4:3 and 16:9,
the former used by most analog television broadcasts, while the latter, also referred to as widescreen – in films, DVDs, and
modern HD video.

A visual comparison of two popular aspect ratios.
To find out a video's aspect ratio:
 
1. Add the video to Movavi Video Converter. Select it in the file list.
2. Open the File menu and select File Information. A dialog box will open containing all the information about the selected
file. You will find Aspect Ratio under Video stream.
 

In this example, we have a 16:9 video.

How to change a video's aspect ratio?
I. Using the Crop effect.
(for any aspect ratios)
1. In the file list, select the videos that you want to crop. You can select more than one video to crop them to the same
format.

2. In the effects panel, click the Crop button . The Crop panel will open, and a frame will appear over the player in
Input mode.
 
3. Find the Maintain aspect ratio option. With this option enabled, the crop frame will be constrained to the proportions of
the original or of the aspect ratio selected from the list beneath the checkbox.
 
If you need to convert the video to 16:9, 4:3 or 3:2 aspect ratio, select the necessary aspect ratio from the list under
Maintain aspect ratio.
If you need a different resolution, you can specify it manually. To do that, deselect the Maintain aspect ratio option and enter
a new frame size
 
II. By converting to a different resolution.
(for changing 4:3 to 16:9 aspect ratio)
 
1. Open the list of presets, click Video and audio formats, and pick a video format. If you don't need to convert the video,
select the format that matches the video's file extension.



 

 

2.  Choose a resolution closest to the original. You will now see black 'pillars' on either side of the video. To remove the
pillars, you can select a different resize method:

2.1 Click Settings. The Settings window will open.
2.2 Under Resize method, select Crop, Stretch, or Auto. You can use the sample picture in the Settings or the
player's Output mode to preview the method that looks best with your video.
2.3 Click OK to accept the changes.

 
When you have applied the necessary aspect ratio adjustments, click Convert to begin changing the files' aspect ratio.
 
Aspect ratios and common resolutions
The following table contains a list of common resolutions along with their aspect ratios.

Standard Definition Resolutions (SD)
240x180 4:3
320x240 4:3
480x320 3:2
640x360 16:9

640x480 4:3
720x480 (NTSC DVD)
720x576 (PAL DVD)
800x480 5:3
854x480 16:9
960x540 16:9

High-Definition Resolutions (HD)
1280x720 16:9
1280x800 16:10

1920x1080 16:9
2560x1440 16:9
3840x2160 16:9
7680x4320 16:9



 

 

Choose audio tracks
It is not uncommon to find video files with multiple audio tracks, and you might want to keep some or all of the audio tracks
when you convert the video, whether they include audio for different languages or the director's comments.
 
Open the audio track panel

Click the sound icon  next to the file to open the list of available audio tracks.
 

Select audio tracks
To convert the file without audio, click the No audio button or manually deselect all tracks. This may be useful if the video
file only has white noise or you do not want to keep the audio: you can slightly reduce the output file size by removing audio.
 
Choose the necessary tracks in the list. You can choose to save all the tracks by clicking Select All.
 

 
You can select as many tracks as you like, but keep in mind that not all formats support multiple audio tracks. You can
consult the table below for information on each format:

 
Format Number of audio tracks supported

3GP 1
AVI 16
DVD 8
FLV, SWF 1
MKV 16
MOV 16
MP4 16
MPEG-1, MPEG-2 16

OGV 1
WebM 16
WMV 16



 

 

Choose a subtitle track
Open the Subtitle Panel
Click the speech bubble icon  next to the file to open the list of available subtitles.
 

 
Selecting a Subtitle Track
If there is only one subtitle track present in the file, it will be
selected automatically.
 
If there are several subtitle tracks stored in the file, simply
click on it in the list of subtitles to select it for conversion.
 
To convert a video without subtitles, simply click the No
Subtitles button.
 
Adding Subtitle Tracks
You can add external subtitle tracks to be stored inside the
video file after conversion. Click the Add Subtitles button
in the subtitle panel and browse your computer for *.srt, *.ass, and *.ssa subtitle files.
 
Subtitle Encoding
If you have subtitles written in a language other than English, they may be encoded with a different character set. By
default, Movavi Video Suite will try to guess the subtitle language based on your system, but you can also manually select
the language from the Subtitle encoding list so that all characters are displayed correctly, especially if you are using
hieroglyphic or right-to-left language subtitles.
 
Use the player's output mode to preview the subtitles and check that the text is displaying correctly.
 
 



 

 

Extract audio from video
Movavi Video Converter can help you convert not only video files into other video formats, but also convert video files to
audio formats, thus extracting the soundtrack from your videos.
 
1. Add video files or DVDs to the program.
 
2. Select a video fragment that you want to extract the audio from. In the preview area, drag the markers from the beginning
and the end of the progress bar so that the necessary fragment is located between them. This way, you can save only the
part you need without having to cut the audio file later.
 

 
3. Select an audio preset:
 
3.1 Click the Convert to field to open the list of presets.
3.2 Open the Video and audio category and scroll to the bottom to find audio preset groups.
3.3 Click on the necessary format group (MP3, FLAC, etc.) to open it and see the available presets. Then, select the bitrate
you prefer. Higher audio bitrates generally mean higher quality, however the file size will also be larger.
To preserve the original quality, choose a preset labeled with Same as input.
If you want to convert audio with multichannel sound, you can use WAV, OGG, or FLAC formats.
 



 

 

 
4. Check the Destination line to make sure you're saving your audio into the right folder and click Convert to start
converting video into audio!
 
* Please note that Movavi Video Converter is not intended for making illegal copies of copyrighted material.



 

 

Creating GIFs from videos
1. Add a video to the program
Click the Add Video button and select the necessary file or drag-and-drop video files onto the file list.
 
2. Trim the video:
Select the video in the file list. Then, in the player area, drag the triangle markers to mark the beginning and the end of the
fragment you want to make into a GIF. When you move a marker, you will see an orange bubble next to it, showing the exact
time position of the selected marker. To set a precise position, click inside the orange bubble and type in the necessary time.
*For more information, see the Trimming Video and Audio section.

3. Select a GIF preset:

• Click the Convert to field to open the list of presets
• Go to Image formats and click the GIF group to see all GIF presets.
• Choose the most appropriate GIF size. You can also make GIF avatars – just choose one of the avatar presets with the

necessary size.

 
4. (Advanced) If you need to change the GIF's frame rate, click the Settings button and select one from the Frame rate list.
Higher frame rates will make the movements seem smoother, but will increase the GIF's file size.
 
5. Click the Convert button to save your GIF image.
 
 
 



 

 

Burn DVDs
Please note that you will need to have Movavi ChiliBurner or Movavi Video Suite installed to use the DVD burning feature.

 
You can use Movavi Video Converter to prepare videos for burning to DVDs with Movavi ChiliBurner.
 
1. Add videos for conversion using the Add Video or Add DVD buttons located in the upper part of the main converter
window or simply drag-and-drop files from Windows Explorer.
 
2. Select the necessary preset:
Click anywhere within the Convert to field to open the preset list and go to Video and audio formats. There, open the
DVD-Compatible Video group and select a preset depending on which TV standard (NTSC or PAL) and quality you need.

 
The TV standard largely depends on the country you live in, or on the country where your DVD player was manufactured:

• NTSC is used in North and Central America, most countries of South America (excluding Argentina and Brazil), Burma,
Japan, the Philippines, South Korea, Taiwan, and Vietnam.

• PAL is used in all countries of Africa, Europe, Oceania, and the Middle East, most Asian countries, as well as in Argentina,
Brazil, Paraguay, Uruguay, and French Guiana

 
3. Now that you've selected a DVD-compatible preset, the Burn to DVD checkbox will appear at the bottom of the window.
Select this option to burn the videos right after conversion.

4. If you will be needing the converted videos later, make sure to check where they will be saved in the Destination line, and
if necessary, specify a new one by clicking the Browse button and selecting a new folder in the Explorer dialogue.
 
5. Click Convert to start the conversion process.
 
6. Once your files have been processed, the DVD burner module will open. Your files will already be added to its list. All you
will need to do now is make sure there is a writable DVD inside your DVD drive and click Burn Disc.
 

http://www.movavi.com/chiliburner/
http://www.movavi.com/suite/


 

 



 

 

Convert audio files
Even though MP3 is still the most frequently used audio format, you may sometimes encounter audio in other formats,
not always compatible with your player or device. On the other hand, if you're an avid music fan, some formats may retain
quality better than others, such as FLAC for storing lossless music. Follow the instructions below to learn how to convert
audio files.
 
Step 1: Add Files
To add audio files to the file list, click the Add Audio  button at the top of the window and select the files you want to convert.
Learn more
 
Step 2: Choose a Preset
Click the Convert to field to open the list of presets and go to Video and audio tab. Scroll to the very bottom of the list to
find audio format groups. Click on a format group to open it and then select the preset that best suits your needs. Here's
everything you need to know about choosing an audio preset:
 
General Audio – this group contains presets for popular audio formats. These are useful if you just want to change the
format without losing quality.
 
Bitrate – the bitrate reflects the amount of data in kilobits that is played back each second. Higher bitrate usually means
higher audio quality as well as larger file size, as extra data needs to be stored within the file. For audio presets, the bitrate is
listed next to the format.
 
When you convert a file to lower bitrate, the extra bits of data are irretrievably lost, meaning that you cannot increase quality
by converting audio to a higher bitrate, because the file no longer contains the data that can be used to restore higher
quality. Therefore, it only makes sense to convert audio to lower bitrates or keep the original bitrate. You can find a file's
audio bitrate in the Input column of the file list next to the video stream.
 
To convert the audio file without changing the bitrate, choose the preset marked Same as input. Please note that some
formats, such as MP3, do not support high bitrates: in that case the file will be converted with the maximum supported bitrate
for that format.
 

 
Step 3: Set a Destination Folder and Convert
 
The Destination line displays the file path to where the program will place the converted files. To change this folder, click
Browse and select the necessary folder using the standard Windows dialogue.
 
If you want to add the files to your iTunes library after conversion, just tick the Add to iTunes checkbox beneath the
Destination line. Please note that you will need iTunes 6.0 or higher installed on your computer.



 

 

 

 
When you've set everything up, click Convert to start the audio processing. Your files will be ready in a few minutes at most.



 

 

Convert images
 
Step 1. Click the Add Image button and select the images you want to convert.

Step 2. Select a format for converting the images:
Click the Convert to field to open the list of conversion presets and select Image formats. Click the necessary format and
select a preset. Social Networking presets allow you to convert images for uploading for popular social networks.

To resize images:
Click the Settings button next to the Convert to field to open the settings for the selected preset. In the Frame size list,
select the necessary size, or select Custom and enter the new dimensions into the Width and Height boxes to the right.
By default, the picture's proportions will be maintained when you enter a new size. If you want to change the size without

keeping the proportions, click the link icon next to the Width and Height boxes:  – constrained proportions,  – free
proportions.



 

 

Step 3. Choose a folder for saving files by clicking the Browse button.
 
To begin saving the images, click the Convert button in the bottom right corner.



 

 

Adding Media for Conversion
Opening files

To begin converting media files, you will need to first open them in Movavi Video Converter.
 
Add media files
1. Click the Add Video, Add Audio, Add DVD or Add Image buttons to open files of the corresponding format.
2. A dialog box will appear. Choose the files you want to convert and click Open.

Drag-and-drop
You can also add files of any format by dragging them from any Explorer window right onto the Movavi Video Converter file
list.



 

 

File list
After you have opened the files, they will all appear in the file list. Here, you can view information about the files, choose
audio and subtitle tracks, and manage the output file.

In the left-hand column, you can find the information about the original (input) file.
In the middle column, you can find the tracks of each video file, and select audio and subtitle tracks.
In the right-hand column (output), you see information about the output file, and manage its quality or change its file name.

 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Change output format
After you've added media files, it's time to choose what you want to convert them to.
 
What is a preset?
A preset is a set of pre-made parameters for converting the files for a specific format or purpose. To convert videos, simply
choose a preset that suits your needs, and all the settings will be automatically set for you. This way, you won't have to worry
about choosing a bitrate.
 
Example:
I want to convert a video for watching on an iPhone 6 → Choose the iPhone 6 preset → The program automatically selects
the perfect format, resolution, and bitrate. 
I want to convert a video for uploading to YouTube → Choose a YouTube HD preset → The program will automatically set
the format, codec, and resolution that is accepted by YouTube for uploads.
 
Step 1: Open the list of presets
Click the 'Convert to' field to open the list of all available presets. First, you will see the most recent and featured output
settings.

Step 2: Find a format
Next, find the format you want to convert the files to. You can use the search field at the bottom of the list, or you can browse
the categories to find the preset you want.
 
Converting video and audio
If you need to convert to a video or audio format, click Video and audio at the top of the list. Inside, you will find groups of
video and audio formats sorted alphabetically with video formats first, and audio formats at the bottom of the list. In addition
to standard media formats, you can find special presets for specific purposes:
 

• General Video, General Audio: using presets from these groups will convert the files changing only the format,
while all other properties, such as resolution and bitrate, will remain unchanged. This allows you to retain the best
quality after conversion.

 
• DVD-compatible Video: using these presets will allow you to burn your video to disc straight after conversion.

 
• HD Video, 4K Ultra HD Video: these presets are optimized for working with high-definition videos with large

resolutions. Note that using these presets is beneficial only of the original video has a very high quality.
 

•



 

 

Upscale SD, DVD to HD: if you need to convert a small resolution video to a large frame size, these presets will
convert the video at a slightly higher quality. However, please note that the output videos will not be a true HD-
quality, since they were created from a smaller resolution. 

 
• HTML5, Online Video, Web-Compatible Video: use these presets if you want to upload the files online after

conversion.

 
Converting images
If you need to convert pictures, click Images at the top of the preset list and choose the image format you want to use.
Learn how to convert images
 
Converting for devices
If you want to watch the video on a device, click Devices at the bottom of the list. Then, find your device's manufacturer and
click the group to open it. Inside, choose your device's model or the one closest to it.
Learn how to convert for devices
 
Step 3: Choose preset
When you've found the preset that you need, click on it to select it. Note that all files currently open in Movavi Video
Converter will be converted using the same preset.
 
Each preset displays the following information:
Format The file's container format is like a box that stores encoded information

about the file's video and audio streams.
MP4
AVI

Video codec A video codec is the way the video stream is encoded or 'packed' into
the video file. Decoding the video then requires a special codec to be
supported in the player. If you're not sure which codec to use, the H.264
video codec is very good in terms of size to quality.
Learn more about formats and codecs

H.264
VP8
MPEG2

Audio codec The audio codec is the way the file's sound is encoded and 'packed'
into the file. If the preset's audio codec is listed as 'Auto' it means that
the original file's audio will be preserved if it is supported by the output
format.

AAC
MP2
Auto

Resolution
(frame size)

The video's frame size is basically its width and height. Using a large
resolution can help you preserve better quality, but only if the original
video has a greater or equal frame size.
Presets marked with 'Same as input' will keep the original file's frame
size, maintaining better quality.

HD 720p
640x480
Same as input

File extension The file extension is usually the same as the container format, and is
shown in parentheses.

(*.mp4)

 

Faster conversion
Some presets may also have an acceleration icon next to them, meaning that if you choose one of these presets, the files
will be converted much faster:

     Converts videos up to 50x faster without quality loss if the input and output files have compatible formats

     Uses the video processing capabilities of your Intel® processor to accelerate video conversion (Only for
compatible Intel® processors)

glossary.htm#container_format


 

 

     Uses your GPU to accelerate video processing (Only for NVIDIA graphics cards)
Learn more about acceleration
 
Advanced settings
If you can't find a suitable preset, you can select the necessary properties manually. Click the Settings button next to the
'Convert to' box to modify the video and audio properties of the currently selected preset.
 



 

 

Advanced Conversion Settings
 After selecting a preset, you can manually modify it to change any output properties. To do that, click the Settings button
next to the 'Convert to' box to open the settings for the selected preset.

To see more settings, click Show Advanced at the bottom of the settings window.
 
Two Pass Encoding
Encoding videos in two passes means that the encoder will go over the media file twice: first, to analyze the file and then
to convert it using the collected data. This takes extra conversion time, however it allows for a higher output quality and
possibly a slight reduction in file size.
 
To enable two pass encoding:
1. Inside the Settings window, click Show Advanced to show the encoding settings.
2. Under Encoding type, choose Two Pass.
3. Click OK to accept the changes.



 

 

Change the output folder
 
The Destination line located in the bottom part of the converter interface allows you to change the folder where Movavi
Video Converter will place the output files.
 

 
The default destination for saving your files is your Movavi Library, located in your Videos folder. However, you can easily
change it using one of the following ways:

• Click the Browse button and specify the necessary folder using the standard Windows dialogue.
• Click the text in the Destination field and type in the necessary path.
• Click the arrow button next to the Destination field. This will open a list which will contain the following options:

• Your Videos\Movavi Library folder
• The output folder is the same as input: selecting this option will place the output files right next to the input

files.
• Any folder paths you have recently used.

 
You can always quickly open the selected folder by clicking the arrow to the right of the Browse button and selecting Open
output folder. This will open the folder in the Explorer window so that you can check its contents.
 



 

 

Editing media files
Trimming videos
If you only want to convert a part of the video, you can trim off the parts you don't want from the beginning and end of the
file.
Learn more about trimming videos

Original video - 5 min. Trimmed video - 30 sec.
Joining videos
If your video footage is in several different files, you don't need to use a full-function video editor to join them together.
Learn more about joining files

Joined videos
Flipping and rotating videos
Nobody likes videos with the wrong orientation! This can be easily fixed with the Transform Video tool which lets you rotate
and flip videos or images.
Learn more about transforming videos

Left to right: original image, rotated 90° clockwise, rotated and flipped horizontally
Cropping videos
Cropping a video can change the video's aspect ratio to remove any black bars around it; you'll be able to use the entire
screen when watching the video. Cropping a video or image can also help to remove unwanted images from the edges of
the screen (for example, if there's a dumpster at the edge of an otherwise beautiful video!) or draw attention to the center of
the frame.
Learn more about cropping

Cropping a video



 

 

 
Changing the aspect ratio
Changing the video's aspect ratio also lets you to make full use of available screnn real estate without black bars. This is
particulary useful if you want to watch old TV-format videos on a new 16:9 screen, or vice versa.
Learn more about aspect ratios

4:3 video turned into 16:9
Adding a watermark
Adding your name or logo on top of the video will make sure nobody else can take credit for your videos.
Learn more about watermarking

Original video; image watermark; text watermark.
Adjusting colors
Using Movavi Video Converter, you can make quick color adjustments to your videos and photos. Use automatic
adjustments for fast enhancement, or adjust the hue, brightness, and saturation manually.
Learn more about video adjustments

Before and after adjustment
Stabilizing video
If your videos have a lot of camera shake, you can reduce the effects using video stabilization.
Learn how to stabilize video

Enhancing audio
Many movies have problems with volume, where the dialogue is too quiet and action scenes blast at full volume. To combat
this, you can normalize the file's audio track using Movavi Video Converter, or adjust the volume level manually.
Learn more about audio enhancements
 
 



 

 

 



 

 

Trim video and audio
If you have a very long and large video but only want to share a part of it with your friends, or you just want to trim some
"garbage" from the beginning or the end of the video, follow these steps:
 
1. Add media for conversion. You can trim both video and audio files in the same way.
 
2. In the Preview Area, drag the triangle sliders from the beginning and the end of the progress bar so that the part of the
video you want to keep is located between them.
 

 
3. That's it! Don't forget to choose a preset and set a destination path. When you click the Convert button, only the fragment
you've selected will be saved in the output file.
 

To quickly trim video and audio files without changing their format:
Open the preset list and go to Video and audio formats. There, open the group with the same name as the file's format
extension (such as *.mp4 or *.avi), and inside it, select the preset marked Same as input.



 

 

Join files
If you have a collection of video clips that you'd like to make into a single video file, you can easily do it it Movavi Video
Converter simply by selecting a checkbox. Just follow the steps below:
 
1. Add the media files you want to join.
You can join video or audio files, as long as you do not mix them together.
 
2. Select the Join checkbox beneath the destination line.

 
All the files in the list will be marked for joining, like on the image below. Your files will be shown as an indented list beneath
a "Joined file" - this upper line represents the resulting file which will contain the videos you've selected.
 
If there are files in the list that you do not want to see in the resulting video, simply uncheck them in the file list.  If you
change your mind later and want to convert the files separately, just uncheck the Join option.
 
3. To change the order in which the videos will appear in the resulting file, drag and drop the files in the list: they will be
joined top to bottom in the specified order. 
 
4. Choose a preset for converting the files.
 
If you are joining files with different resolutions, they will all be converted into the specified preset, however, if you select a
preset marked with Same as input, the files will be converted with the resolution and other parameters of the first file in the
list. You may also want to go into Settings and specify a resize method that works best your videos, for example, if you
want to avoid black bars. Also, please note that SuperSpeed mode is not available when joining files.
 

Attention!
If your files have multiple audio tracks, please select the same number of audio tracks for each file before joining.

To learn more about managing audio tracks, see the Choosing Audio Tracks section.
 
5. That's it! All you need to do is click Convert to start joining your videos.

 
 

 



 

 

Flip and rotate video
The Transform Video effect can help you rotate or flip a video any way you want.
 
1. Add videos or DVDs to the file list.
 
2. Select the video you want to transform in the file list. You can select multiple videos if you want to transform them in the
same way.

3. Click the Transform Video  button below the file list. The Transform Video panel will open. Use the buttons on the
panel to transform the video:
 

 Rotate the video by 90 degrees counterclockwise.

 Rotate the video by 90 degrees clockwise.

 Flip horizontally.

 Flip vertically.
 
You can preview the changes in Output mode.
 
4. To accept the changes, click Apply.

The selected video's thumbnail will also be marked with a star icon. Right-click the star icon to see which effects have been
applied to it. Here, you can also click the  icon next to an effect to remove it.

Now you can go on to choosing a preset and setting a destination path. Once you're done, click Convert to start the video
processing.



 

 

Crop video
1. Add the files you want to crop. Select a file from the list. You can select more than one video if you want to crop several
videos in the same way.

2. Click the Crop button  on the effects panel. The Crop panel will appear, and the video will be displayed with a crop
frame.
 
3. Adjust the size of the cropped area.
 

• In the player area (Input mode), drag the edges of the frame to define the size of the area you want to crop. You can also
set precise dimensions in the Width and Height fields of the Crop panel.
 

• If the Maintain aspect ratio option is selected, the proportions of the video will be constrained to that of the original.
However, you can select a different standard aspect ratio, such as 16:9 or 4:3, or deselect the Maintain aspect ratio
option and freely set the new frame size.
 

• To change the position of the new cropped frame, drag the crop rectangle in the preview area to the desired position.

 
4. Click Apply to apply the changes to the selected videos.
You can preview the cropped video in Output mode.

 



 

 

Add a watermark
Movavi Video Converter allows you to add both text and image watermarks to videos and images. You can use them to add
any kind of logos or signatures.
 
Applying a Text Watermark
1. In the file list, select the file that you want to apply the watermark to. You can also select multiple files if you want to apply
the same watermark to all of them.

2. On the effects panel, click the Text Watermark button: . The Text Watermark settings panel will open.

3. Enter the text into the box and set up the font and color.

 – opens the font selection dialog box

 – allows you to select the main text color

 – allows you to select the text outline color
You can also set transparency for the watermark text.
 
4. Place the watermark inside the video frame.
Make sure that the player is in Output mode. You will see the text you've entered in the video preview. Drag the text with the
mouse to place it where you want within the frame.
 
5. Click Apply to save the changes.

Applying an Image Watermark
1. In the file list, select the file that you want to apply the watermark to. You can also select multiple files if you want to apply
the same watermark to all of them.
 

2. On the effects panel, click the Image Watermark button: . The Image Watermark settings panel will open.

3. Click Browse to open a watermark image. If necessary, adjust the transparency if you want the image to be see-through.
 
4. Place the watermark inside the video frame.
Make sure that the player is in Output mode. You will see the image in the video preview. Drag the image with the mouse to
place it where you want within the frame. To resize the watermark image, click and drag one of its corners.
 
5. Click Apply to save the changes.

Once you apply one of the watermark effects, the video will be marked with a star icon. You can right-click it to see a list of
applied effects. Here, you can also remove an effect by clicking the  icon next to it.



 

 

All that's left is to select an output format, specify a destination folder, and click Convert to start video processing.



 

 

Adjust video colors
Not all videos turn out perfect: some may be slightly darker or less saturated than we want them to be. Luckily, you can
adjust your videos' brightness, contrast, hue, and saturation right from the converter!
 
1. Add videos to the file list.
 

2. Select the video you want to adjust and click the Video Adjustments  button underneath the file list. The Video
Adjustment panel will open.

 
3. Pull the sliders to set the desired adjustment levels. You can also select the automatic adjustment options on the right.
The Magic Enhance option will automatically adjust the video's brightness and contrast for you.
 
Make sure that the player is set to Output mode so that you will be able to see the changes.
 
4. Click Apply when you're done.

 The video's thumbnail will now be marked with a star icon. You can right-click it to see a list of applied effects. Here, you can
also remove an effect by clicking the  icon next to it.

All that's left is to select an output format, specify a destination folder, and click Convert to start video processing.
 
 



 

 

Stabilize video
Videos shot on handheld cameras often look shaky and unstable, no matter how hard you try to keep the camera level,
especially if you're filming sports using a portative camera such as a GoPro®. To remove camera shake from your videos:
 
Step 1: Add files
Add the videos you want to stabilize.
 
Step 2: Click the Stabilize Video button
On the effects toolbar under the file list, click the Stabilize Video button to open the stabilization panel.

Step 3: Enable stabilization.
On the video stabilization panel, select the Stabilize video option and click Apply.

Step 4: Convert
Finally, select a destination folder and click Convert to start stabilizing the video. Note that conversion will take longer than
usual because of the stabilization effect.



 

 

Enhance audio
Movavi Video Suite can help you adjust the volume levels of any video or audio file.
 
To adjust audio:
 
1. Add the files that you want to adjust.
 
2. Select the file or files that you would like to adjust.

3. Click the audio adjustment button on the effects panel:  The Audio Adjustments panel will open.
 
4. Use the slider to adjust the volume relative to that of the original video. If parts of your video are louder or quieter than
others, we recommend that you select the Normalize volume option to even out the volume levels throughout the video.
 
5. Click Apply to apply the effect to the selected files.

The video's thumbnail will now be marked with a star icon. You can right-click it to see a list of applied effects. Here, you can
also remove an effect by clicking the  icon next to it.

All that's left is to select an output format, specify a destination folder, and click Convert to start video processing.



 

 

Reduce file size
Converting videos can often help to compress large files and save disk space. Here are the steps to convert videos to a
smaller file size. Note, however, note that if you reduce file size, and consequently the amount of data in a video file, you will
inevitably lose some quality.
 
Step 1: Add files
Open the files you want to compress and choose the format you want to convert them to.
Learn how to select a format
 
Step 2: Reduce quality
Slightly reducing the video's bitrate can make the video file size much smaller, without visibly affecting its quality.
 
1. Click the output file size in the file list. You will see the size and quality options for this file.
2. To reduce the file size, you can lower the file's bitrate (quality) or its resolution. Even a small change in quality or
resolution can save a lot of disk space without making the video look worse. If you need the video to fit within a certain size,
enter that into the Size box, but check the Quality reading before continuing to make sure it is not too low.
3. Click Apply to accept the changes.
4. You may want to check that the output video still looks good. Click the Output button under the player to see a preview of

how the video will look after conversion. Then click the Full Screen button  to view the preview full screen, and look for
any video artefacts that may have appeared if you've set the quality too low.

Hints & Tips:

• Use a preset with the H.264 codec for the best size-to-quality ratio.
• Choose a smaller resolution
• Trim the video and save only the best parts

 
Step 3: Compress video
Check the video quality in the preview player, then click Convert to start processing the files.

 

choosing_a_preset.htm#choose_preset


 

 

Sharing and exporting
Movavi Video Converter includes various options for sharing your videos with friends, family, or the whole world! You can
add your videos to iTunes or upload them to a number of social networks and video hosting sites. What is more, you can do
it by simply selecting a checkbox beneath the Destination line.
 

 
Adding Videos to iTunes:
If you want to add your files to the iTunes media library after conversion for uploading it to mobile devices or storing them in
your iCloud, you can easily do so by checking the Add to iTunes checkbox. Please note that you will need to have iTunes
6.0 and higher installed on your computer before starting the conversion process.
 
Uploading Videos to the Web:
Please note that you will need to have the Share Online module installed to use the uploading feature. If Share Online is
not found on your computer, you will be prompted to download and install it. Don't worry: it's completely free, and it shouldn't
take more than a couple minutes! You can always manually download it from our website: http://www.movavi.com/photo-
video-uploader/
 
Check the Upload to checkbox and then click the arrow next to it. You will then see the following pop-up:
 

 
Simply put a checkmark next to the websites or services that you want to upload the videos to. Once the conversion process
has finished, the Share Online module will open, and you will be able to upload your videos. If necessary, add a description,
some tags, change the category and privacy settings and you're ready to go! Click Upload to start the uploading process.
 

http://www.movavi.com/photo-video-uploader/
http://www.movavi.com/photo-video-uploader/


 

 

 
 
 



 

 

Take a video snapshot
To save a single frame form the video:
 
1. In the player, move the progress marker onto the moment you want to capture.
 
2. Under the player, click the Snapshot button.
 
3. A Explorer window will open. Choose where you want to save the snapshot and click Save.
 
The snapshot will be saved with the original video's size and quality.



 

 

Accelerate conversion
Movavi Video Suite supports the latest Intel® and NVIDIA® hardware acceleration technologies, allowing you to use your
computer's full potential for converting videos without hindering performance in other programs. Furthermore, the special
SuperSpeed mode allows you to save time when converting videos to formats with compatible codecs, allowing to skip the
re-encoding process and convert files up to 79 times faster.
 
Enabling acceleration:
In the main window, open the Settings menu and select Preferences. The Preferences window will appear. Click the
Acceleration button at the top to switch to the Acceleration tab.
Then, simply check the corresponding checkboxes to enable SuperSpeed mode, Intel®, or NVIDIA® hardware acceleration
and click OK to apply the changes and close the window.
 

 
 
 



 

 

SuperSpeed conversion
SuperSpeed conversion is an innovative technology which allows you to convert video and audio files of compatible formats
up to 79 times faster than usual without quality loss.
 
When you convert videos, most of the time is usually devoted to re-encoding the video stream from one codec to another,
which often causes quality loss. With SuperSpeed mode enabled, Movavi Video Suite can skip the re-encoding process and
simply copy the video stream from one format to another, effectively converting an entire video with the speed of copying
and with zero quality loss.
 

To make the most of SuperSpeed mode, select output presets that are marked with a green SuperSpeed icon ( ).
This means that the videos you have added are compatible with the selected format and can be converted much faster.
 

However, as SuperSpeed conversion does not re-encode video or audio streams, it can only accelerate conversion under
the following conditions:

• The codec, resolution, bitrate, and other video parameters remain unchanged
• The video is not rotated or compressed

 
Therefore, if you change the video resolution or any other parameters, the conversion will run as usual. Don't worry, it's still
very fast!
 
More information:

• Enabling SuperSpeed mode in Preferences
• List of formats compatible with SuperSpeed mode



 

 

Compatible Formats
You can use the following table to check whether a particular format can be converted in SuperSpeed mode:
 

Output formats Device presets*Input
formats

and
codecs

AVI FLV M2TS MKV MOV MP4 MPG iPad3
iPad 4

iPhone 5S,
iPhone 5C,
iPhone 4,
iPhone 4S

Kindle Fire HDX
Kindle Fore

HD 8.9"
Kindle Fire HD 7"
Kindle Fire Tablet

Google
Nexus 4
Google
Nexus 7
Google

Nexus 10
AVI
(H.264)

 

AVI
(MPEG-4)

         

FLV
(H.264)

 

M2TS
(H.264)

 

M2TS
(MPEG-2)

         

MKV
(H.264)

 

MOV
(H.264)

 

MP4
(H.264)

 

MP4
(MPEG-4)

         

MPG
(MPEG-2)

         

* SuperSpeed conversion to a device preset is available if the input file resolution is no higher than the device resolution: 1280×720 for iPad 3/4, Amazon
Kindle and Google Nexus, 1136×640 for iPhone 5/5C/5S, and 960×640 for iPhone 4/4S.
 



 

 

Enabling SuperSpeed Conversion
 
1. In the main converter window, open the Settings menu and click Preferences to open the program preferences.
 
2. In the Preferences window, click the Acceleration button to access various acceleration options.
 
3. Select the very first option: Enable SuperSpeed conversion. Click OK to save your preferences and return to the main
window.
 



 

 

Watch Folder
The Watch Folder option can monitor a folder for changes and convert any new files to the format of your choice. If you
frequently convert videos to one format, you will only need to set it up once and then simply take the converted videos
whenever you need them.
 
Setting up automatic conversion:
 
Step 1: Open Watch Folder options
Click the Watch Folder button at the top of the window to see folder monitoring options.

Step 2: Choose a folder
Click the Browse button next to the 'Monitor folder' box and choose the folder you want to monitor and convert files from.
For example, this can be your downloads folder if you want to convert any new videos you download.
 

 



 

 

Step 3: Choose a format
Next, open the 'Convert to' list in the Watch Folder window and select the preset you want to use for converting all of the
files in the specified folder.
Choosing the output format

Step 4: Set up conversion options
 
In the After conversion option, choose what you want to happen to the original files after they've been converted:

Delete original files: the files will be deleted as soon as they are finished converting.
Move original files to a subfolder: the original files will be moved to the 'Originals' folder inside the monitored
folder. These files will not be converted a second time.
 

Launch at system startup: enable this option if you want the folder monitoring to resume after you restart the computer.
 
Show conversion notifications: select this option if you want to be notified every time a file has finished conversion or if
there's an error.

 
Step 5: Start monitoring
Finally, click Start Watch Mode to begin monitoring the selected folder. The Converter window will be minimized to tray and
keep working in background mode.



 

 

Conversion log:
If you've already used Watch Folder, you can see a detailed list of all conversion events that occurred in Watch Folder
mode. To do that, open the Watch Folder window and click View Log at the bottom. Here, you can see whether all files were
converted correctly.
If you want to keep this log as a text file for future reference, click Save Log and choose a location for saving the log file. To
delete all previous entries, click Clear Log.



 

 

Energy-saving options
If you are running a batch conversion for very large files, the process may take a while even on fast computers. The energy-
saving options allow you to shut down or hibernate your computer after it is done converting the files.
 
1. Open the Convert menu
2. Go to the After Conversion section
3. Select Shut Down or Hibernate.

If you change your mind, you will be able to disable shutdown or hibernation during conversion. Please note that if you use
any of the energy-saving options, iTunes and web uploading will be temporarily disabled. The next time you launch Movavi
Video Converter, the energy-saving options will be automatically turned off.
 
 



 

 

Movavi Video Converter Settings and Preferences
 
How to open the converter preferences:
1. Open the Settings menu.
2. In the Settings menu, click Preferences.
The Preferences window will open. At the top, it is divided into three tabs: general preferences, conversion preferences, and
acceleration preferences.
 

General Preferences
 
Language – changes the interface language of Movavi Video Suite.
 

 Check the Automatically check for updates box to make sure your Video Converter is always up-to-date.
 

 Show hints and tips – toggles whether the program will display help pop-ups. You can also select Don't show anymore
on any pop-up to turn it off.

Conversion Preferences
 
Output file name – determines the course of action if the output folder already contains a file with the specified name when
a new file is being placed into the folder during conversion:

• Overwrite existing file - the old file will be permanently replaced with the newly converted file.
• Automatically rename files - new files will be automatically renamed, and both files will be preserved.

 
After conversion:

 Open output folder - if this option is enabled, the folder containing your newly converted files will be opened
automatically as soon as the conversion process is finished.

 Play notification sound - if this option is enabled, the program will notify you when it has finished converting your files.



 

 

Acceleration Preferences
 
Enable SuperSpeed conversion: check this option to enjoy unmatched conversion speeds for compatible formats.
Learn more about SuperSpeed mode



 

 

Record computer screen
With Movavi Screen Capture, you can record any part of your screen with audio and save the resulting video in any format
you like.  When you open Movavi Screen Capture, you will see a control panel window, where you can set up your capture
preferences, and an orange frame which allows you to select which part of the screen you want to record.

What can I do with Screen Capture?
Record screen

Record online video
Capture a Skype call

Capture video from players
Record audio

Record a tutorial
 

How to use Screen Capture
Step 1: Set up the capture area

Choose a full screen capture mode or click
the crosshairs button to select a window.

Step 2: Set up sound
Choose whether you want to record audio

from your speakers or the microphone.
Step 3: Extras

Use extra options to enrich your recording.
Schedule events
Highlight cursor

Record keystrokes

Step 4: Record screen
Start the recording by clicking the REC button.

Press F8 to take a snapshot.
Press F10 to start and stop the recording.

Press F9 to pause the recording.
Step 5: Save the result

Learn how to save your recording to a common media format.
Edit captured videos
Reduce output size



 

 

How to open the capture module
To open the screen capture module:
 
From launch module
In the Movavi Video Suite launcher, click Record computer screen on the Video tab.

From Video Editor
If you want to add a captured video to your movie, click the Record screencast button on the Import tab in the video editing
module. The capture module will open. After capturing your screen, click the Edit button in the saving window. The recording
will be added to your project in Video Editor.



 

 

Recording screen activity
Step 1: Launch the Screen Capture module
Open Movavi Video Suite and click Record computer screen on the Video tab to launch the screen capture module.

Step 2: Choose the capture area
First, you'll need to set which part of the screen you want to record.
 
To record the full screen
Open the list in the left part of the control panel and choose your display under Full Screen.

To record a window
On the capture control panel, click the crosshair button and then click on the window you want to capture. An orange capture
frame will appear around the window, and the window's title will appear on top of the frame.



 

 

To record a custom fragment
On the capture control panel, click the crosshair button. Then, click and drag to draw the capture area on the screen.
Learn more about the capture area

Step 3: Choose audio sources
Next, we'll select what sounds you want to be heard in your video.
 
Music or sounds from your computer
To enable recording sounds from your computer (any music, videos, applications, and alerts), click the System Audio
button. Use the slider to the left of the System Audio button to manage the volume of the recording.

on          off



 

 

Microphone or audio device
To record from an external device, click the microphone button and select the device you want to use from the list below it.
Use the slider to the left of the microphone button to manage the device's volume.
Learn more about audio

on          off
Step 4: Extras

If you want to limit the length of the recording or record at a later time, use the Capture time options button: 
Learn more
 

If you want to display your mouse during capture, click the Cursor options button: 
Learn more
 

If you want to show which keys you pressed during recording, click the Record keystrokes button: 
Learn more
 
Step 5: Record the screen
When you're ready, click the REC button to begin recording. The capture control panel will change to show recording
options. Here, you can also keep track of how big the recording is going to be.

To pause the recording, click Pause. When you're ready to continue, click the Resume button.
To finish the recording and proceed to saving, click Stop.
To terminate and delete the recording, click Cancel.
Learn more

Step 6: Save the video
After you end the recording, you can preview the result and choose how you want to save the captured video.
 
Click the 'Save as' box and select the format you want to save the video in.
 
To save as a video format
Click Video and Audio at the top of the list and select the necessary format and resolution.
 
To save for watching on a device
Click Devices at the top of the list. Find your device's manufacturer and click on it, and then select the device's model. This
will save the video in a format that is guaranteed to be supported by the selected device.



 

 

Finally, click Save to start processing the video.
Learn more about saving videos



 

 

Capturing online video
This manual describes how to capture videos from YouTube. You can also follow the same steps to capture video from other
video sharing websites, webinars, sports broadcasts and any other online video.
 
Step 1: Launch the Screen Capture module
Open Movavi Video Suite and click Record computer screen on the Video tab to launch the screen capture module.

Step 2: Choose video quality
Many video streaming websites, including YouTube, allow you to select the quality for playing back the video. For the best
results, choose the highest available video quality  and, if possible, allow the video to load fully before starting capture.
 
Step 3: Define the capture area
In the Select Capture Area section, open the list of pre-defined capture area sizes and choose one from the YouTube
section:
 

640х360 – default YouTube player size

854х480 – extended theatrical mode size. You can toggle sizes by clicking the Theatrical mode  button in the
YouTube player. 

The capture area frame will be set to the selected size. Then, place the frame over the YouTube player so that the player's

control panel is outside the frame by dragging the frame by the orange position icon .
If you want to capture a fullscreen video, open the list of pre-defined sizes and choose the option under Fullscreen. If you
have more than one monitor, you will be able to choose which one to use for capturing video.



 

 

You can find out more about setting up the capture area here.
 
Step 4: Choose an audio source
On the capture settings panel, click the System Sound button to enable capturing sounds from programs and your system,
including the online video player.
 

off            on
 

Make sure that other sound sources on your computer (for example, videos, streaming music, and ads in other browser tabs,
audio players) are muted or disabled to avoid capturing unnecessary sounds. Next, to further reduce noise, we recommend
that you disable capturing audio from external devices.

off               on
If your computer is running Windows XP, please refer to Troubleshooting in the Recording Audio section for capturing
system sounds.
 
Step 5: Set up mouse visibility

Click the cursor icon  to display the mouse cursor settings panel. To hide the cursor during recording, disable the Show
cursor option.
Learn more about additional capture options
 
Step 6: Start recording



 

 

Make sure that the window with the video player is in the foreground of your desktop. If you've selected the fullscreen
capture mode, don't forget to enable fullscreen playback in the player as well. When you're ready, click the REC button or
use the start capture hotkey to begin recording. The Movavi Screen Capture control panel will switch to recording mode.

During capture, you can temporarily pause the capturing process. If you're capturing in fullscreen mode, the control panel
will be minimized to the system tray. In that case, you can click the icon  in the tray to pause or stop capture, or use the
hot keys.

Step 7: Save your video
To finish recording and proceed to saving your video, click the Stop button or use the F10 key (the default stop capture
shortcut, your keyboard shortcut settings may be different). The player window will appear.
 

In the Save as list, choose a format you'd like to save the video in and click Save. Your video will be ready in a few minutes.
Learn more about saving captured videos

program_preferences.htm#hotkey_preferences
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Capturing Skype calls
When you record audio or video calls using Skype or a similar program, it is important that you record both ends of the
conversation. To do that, you will need to record input from your microphone or webcam, as well as the audio from your
speakers. Follow the steps below to record Skype calls with audio.

 
Step 1: Launch the Screen Capture module
Open Movavi Video Suite and click Record computer screen on the Video tab to launch the screen capture module.

Step 2: Select audio sources
 

• Click the System Sound button to enable capturing the sounds that you hear in your speakers, including your Skype
interlocutor. 
 

• Click the microphone icon to enable capturing audio from external devices.
 

• Open the list beneath the microphone icon and select your microphone or another device that will capture your voice.

Step 3: Set up the capture area
 Adjust the size of the Capture Area to the call window. To do that, click the crosshair button in the left part of the window,
and then click and drag your mouse from one corner of the Skype call area to another. When you release the mouse button,
the Capture Area will have the same size and position as your Skype window.
You can find more information on how to set the size and position of the Capture Area in the Defining the Capture Area
section.

Step 4: Call and record



 

 

Now that everything is set it's time to make that call!
Click the orange REC button to begin recording your call.

You will be given a five-second countdown to prepare. If you want, you can disable the countdown window in General
Preferences.

 
Step 5: End call and save
When you're done, click Stop in the main Movavi Screen Capture window or press F10 to finish capturing and proceed to
saving the video.
You can change the Stop Capture hotkey in Preferences under Keyboard Shortcuts.

program_preferences.htm#general_preferences
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Capturing video from players
Step 1: Launch the Screen Capture module
Open Movavi Video Suite and click Record computer screen on the Video tab to launch the screen capture module.

Step 2: Set up the capture area.
For capturing videos playing in video player applications, it is best if you capture the video as close to its original size as
possible. That is, if the video you want to capture has a resolution of 1280x720 pixels, we recommend that you set the
capture area to the same size. Most video players have a Zoom option, where you can set the zoom level to 100% or 1:1. If
the video is larger than your screen size, you can set the capture area to record the entire screen and then play the video in
full screen mode.
 
To set a fullscreen capture area:
In the Select Capture Area section, open the list of pre-defined capture area sizes and select the option under Fullscreen.
If you have more than one monitor, you can choose which monitor to use for fullscreen capturing.
 
To capture a player window:
Click the crosshair button in the Select Capture Area section to enable smart capture area selection. The screen will dim
slightly. Then, draw the capture area inside the player, so that the player's window is completely outside the frame. When
you release the mouse button, this rectangle will be set as your capture area.
Learn more about the capture area

Step 3: Set up the sound
When you want to record audio from applications, you will need to enable the System Sound option. Click the speaker icon
to enable capturing sound from players and other programs. As this allows to record all system sounds, make sure to disable
sound alerts in other applications to avoid unwanted noise in your video.
Learn more about sound recording
 

on          off
 



 

 

Step 4: Start Recording
To begin recording, click the red REC button or use your Start\Stop capture shortcut.

If you want to capture a fullscreen video:
1. If you don't remember your start and stop capture hot keys, open the Preferences window, and review them or set
different ones in the Keyboard Shortcuts tab. Don't forget to close the preferences window before starting playback.
2. In your player, switch to fullscreen mode and launch playback.
3. To begin recording, press your Start\Stop capture keyboard shortcut. 
 
When you want to end capture, click the Stop button or use the Start\Stop capture shortcut again and proceed to saving
your video.
Learn more about recording videos
 
Step 5: Save the Video
After you've finished capturing the video, you can preview the result in the player and save the video.
If you want to trim the video, move the triangle markers on the progress bar towards the center.
Open the list under Save as and choose the format you want to save your video in. You can also prepare the video for
viewing on mobile devices or sharing online. When you've selected a format, click Save to begin processing the video, or
click Edit to open in in a new Video Editor project. 
Learn more about saving captured videos

Troubleshooting:
Some video player programs have video output settings that prevent capturing video and taking screenshots. If you are
having trouble recording video from any of the following players, follow the steps to change the player's settings and enable
video capturing.
 
Capturing video from VLC (VideoLan Media Player)
(for Windows XP users)
1. In VLC player, open the Tools menu and choose Preferences.



 

 

2. Switch to the Video tab (in Simple mode)
3. In the Display section, find the Output list. If DirectX (DirectDraw) video output is selected, try using a different output
mode.
 
Capturing video from Media Player Classic
(for Windows XP users)
1. In Media Player Classic, open the View menu and select Options.
2. Go to the Playback > Output section in the tree on the left.
3. Find the DirectShow Video option. Here, you can choose from a list of video renderers that will affect how the player
displays video on your screen. If the Overlay Mixer Renderer is selected, select any other renderer from this list.
4. Click OK to accept the changes.
 
Capturing video from Windows Media Player
(for Windows XP users)
1. In the main player menu, open the Tools menu and select Options.
2. In the Options window, switch to the Performance tab.
3. Click the Advanced button.
4. In the Video Acceleration section, find the Use overlays option and deselect it.
5. Click OK to accept the changes.



 

 

Record audio only

Movavi Screen Capture can help you not only record any screen activity, but it can also function as a sound recorder to
record online music, radio broadcasts, and voice input.
Note that you can also record audio using the Record sound button on the Audio tab.
 
Step 1: Launch the Screen Capture module
Open Movavi Video Suite and click Record computer screen on the Video tab to launch the screen capture module.

Step 2: Set up Audio
Naturally, if you want to record an audio file, you'll need to enable audio recording.

• To capture audio from your computer, make sure that the System Audio option is enabled.
• To capture audio from a microphone or an external device, click the microphone icon and choose the device you

will be using for recording.
• To capture Skype audio, you'll need both options enabled in order to capture the audio from the other end of the

call as well your own microphone input.

Here, both System Audio and device recording are enabled.
 

Troubleshooting audio:
If you don't see the device you want to use in the list, it may be disconnected or disabled in system settings.
1. Right-click the sound icon in the Windows notification area and choose Recording Devices from the pop-up menu. The
Sound settings window will open.
2. In the Recording Devices window, look for the necessary device in the list. If it is detected and enabled in your system,
there should be a green checkmark beside it.
3. If you cannot find the device in the list, right-click anywhere in the list and make sure that the options Show Disabled
Devices and Show Disconnected Devices are selected.
4. If the device is listed as Not Plugged In, try plugging in the device again.
5. If the device is listed as Disabled, right-click the device and choose Enable.
 
Step 3: Set up Video
No video:



 

 

If you'll only be recording the audio, or if there's no video at all, we recommend that you make the capture area smaller, so
that video recording does not unnecessarily take up your disk space. To do that, you can resize the capture area with your
mouse, or enter smaller dimensions in the Movavi Screen Capture window. You can set the capture area to as small as
16x16 pixels.
 
With video:
If you'll also be recording video, move the capture area over the video:

• Drag at the orange square in the center of the capture area to move the frame
• Drag at the corners of the frame to resize the capture area.

More on setting up the capture area

Step 4: Record
Click the REC button to begin recording. You will be given a 5-second countdown to start the audio playback (don't worry
you will be able to trim the file later if you accidentally record some silence). When you're done recording, click the Stop
button.

Step 5: Save Audio
When the recording is finished, you will see a player window, where you can preview and save the recording as an audio file.
 
Trim the file:
If you've accidentally recorded some unwanted parts, like silence at the beginning or at the end of the file, you can easily
trim them before saving the file. At both ends of the progress bar, you will find a pair of triangular trimming markers. These
markers control which part of the recording is saved in the output file. Move the triangle markers so that the unwanted parts
are outside of them.



 

 

Trimming markers
Save the file:
1. If you're ready to save the audio file, open the Save as list and click the Video and audio tab at the top of the list.
2. Scroll to the very bottom of the list to find audio formats and choose the format you like. If you're unsure, you can use
*.mp3, as it is the most widely supported format.
3. Click the Save button to start saving the video.

 



 

 

Make a video tutorial
Step 1: Launch the Screen Capture module
Open Movavi Video Suite and click Record computer screen on the Video tab to launch the screen capture module.

Step 2: Record your screen
1. In the Movavi Screen Capture window, select the area of the screen that you want to record. Learn more
2. Choose which audio that you want to record: system audio to record sound you can hear from your speakers or
microphone to record your voice. Learn more
3. Click the mouse cursor icon on the control panel and set up mouse cursor highlighting. This will help you bring attention to
your actions on screen as you record the tutorial. Learn more
4. Click REC to start recording. When you're done, click Stop to proceed.

Step 3: Add the video to the Editor
1. After you've captured your screen, click the Edit button to open the captured clip in the Editor. You will be asked to choose
an aspect ratio for your project. Editing captured files | Setting up a project
2. In the Editor, click Add Media Files if you want to add more clips to your project.



 

 

Step 4: Cut the video
To cut the captured video, select the clip on the Timeline, place the position marker where you want to cut the clip, and click
the scissors button on the toolbar. Cutting video

 
Step 5: (Optional) Record and edit audio
To record an audio voice-over:
1. On the Timeline, place the position marker to where you want the audio to start.
2. Click the microphone button on the toolbar to open recording options.
3. Select your microphone under Audio device, set up the volume and click Start Recording. When you're done, click Stop
Recording, and you can find your voice-over as an audio clip on the Timeline.
Learn more about recording
Audio tracks



 

 

To manage the volume for any clip, select it on the Timeline and open the Tools tab. There, set the Volume slider to the
necessary level for this clip.
Learn more about volume levels
 
Step 6: (Optional) Record video from a webcam
Many video tutorials and webinars also have the author's webcam video in the corner. Adding your own webcam video is
easy: first, record the video and then insert it as an overlay.
1. In the Editor, click the Record Video button on the Import tab.
2. The video recording module will open.  There, choose your webcam under Video capture device, choose a microphone
under Audio capture device, and then click Start Capture.
3. When you're done recording, click Stop Capture, and then Back to editing to add the video you've just recorded to the
Timeline.
Learn more about recording video

4. The recording will appear at the end of the video track of the Timeline. To create an overlay, select the webcam clip and
drag it up, towards the top of the Timeline and place it onto the overlay track. The video will now appear in a small part of
the frame over the main video track.
 



 

 

5. To change the overlay placement, double-click the overlay clip. Now, you can move and resize the overlay in the player.
Click Apply on the options panel above the player to accept the changes. Now you have both your captured screen and
webcam in the same video.
Learn more about overlays

Step 7: (Optional) Highlight objects
In addition to highlighting the mouse cursor, you can bring attention to parts of the screen using the zoom and highlight tools.
1. If you have a long recording but you only want to zoom or highlight a part of its length, cut this part into a separate clip and
select it. Cutting clips
2. Open the Tools tab without deselecting the clip. Here, find the Zoom and Highlight and Conceal tools. Tools
3. To zoom in on a clip, select one of the Zoom modes. Then, in the player, select the part of the screen that you want to
enlarge and click Apply in the Tools tab.
4. To highlight a part of the screen, select Highlight inside the Highlight and Conceal tool. Then, use the frame in the player
to select the part of the screen you want to highlight and click Apply in the Tools tab.
 
Step 8: Export the video
Now that you're done with your tutorial it's time to save it in a format that everyone can enjoy.
1. Click the Export button to open the exporting options.
2. In the Export window, select a video format that you want to use and choose a folder to save the video to.
3. Click Start to begin exporting the video. This may take a few minutes.
Learn more about exporting



 

 

Capture area
The orange frame defines which part of your screen will be visible in your screen recording.
 
Record full screen
To record a full screen video, open the list on the control panel and select your display.
Note: if you have enabled the capture control panel, it will be visible on full-screen recordings. You can disable it in the
Screen Capture Preferences.
Also, the main Movavi Screen Capture window will hide, but you can use keyboard shortcuts or the tray icon to begin
recording.

Record a window
Using the smart selection tool, you can select any window and the frame will be automatically set to its size and position.
1. Click the crosshair button on the Movavi Screen Capture window.
2. The screen will dim slightly. Move your mouse pointer over to the window you want to capture and click on it. An orange
frame should appear around the window.
If you move the window, the capture frame will also follow.

Record a YouTube player
1. Open the list on the Movavi Screen Capture window. There, find the YouTube section and select the size you need. The
smaller size is the regular player size, while the larger size is YouTube's Theatrical Mode.

2. Click and drag the orange square  in the center of the capture frame to move it over the YouTube player.
Learn more about capturing YouTube
 
Record a standard size
You can select from any of the standard or widescreen sizes that match common screen resolutions and windows.
1. On the Movavi Screen Capture window, open the list under 'Select Capture Area'.
2. Select a size that fits your needs.

3. Click and drag the orange square  in the center of the capture frame and move it to the necessary position.
 
Custom frame size
You can set virtually any frame size for your recording using a number of ways:



 

 

 
Draw the capture frame
1. Click the crosshairs button on the Movavi Screen Capture window to enter smart selection mode.
2. The screen will dim slightly. Click and drag diagonally to draw the capture frame rectangle.

Exact size
If you want to set a specific size, enter the width and height into the boxes on the Movavi Screen Capture window:

Drag the edges
Move your mouse pointer over the edge of the capture frame, and click-and-drag at them to change the size of the frame.

Moving the capture frame



 

 

To move the capture frame, click and drag at the orange square in the center of the capture frame to move it across the
screen.

 



 

 

Sound
Movavi Screen Capture can capture sound from a variety of sources. 
 
System Audio
To capture audio from applications, music, videos, and other system audio, click the System Audio button to enable
capturing sound from these sources.
 

on          off
 
Recording Devices
If you want to record audio from external devices:
1. Click the microphone button to enable device capturing.
2. Select the necessary device from the list.

on          off
 
If you want to record both system audio and an external device (for example, to capture Skype calls), simply select both
options.

Troubleshooting
Capturing system sound on Windows XP
Windows XP does not support recording from multiple audio sources: that is, you will not be able to easily capture system
sound and an external audio device. However, you can still capture system sound separately:
1. Click the microphone button to enable recording from audio devices.
2. Select Stereo Mix.
 
See also:
Recording only audio
Recording Skype calls



 

 

Scheduling
You can use Movavi Screen Capture to record your screen at any time.
 
To set a time limit
If you want the recording to end automatically after a certain period of time:
1. Click the clock icon to open the capture time options.

2. Select the 'Stop capture after' option.
3. Enter the time after which the recording should end (hours:minutes:seconds).

To schedule a recording
You can record anything on your screen without even being at your computer, as long as you know when to start and end
the recording.
1. Click the clock icon to open the capture time options.

2. Select the 'Schedule recording' option.
3. Next to Start time, enter the date and time when the recording should start.
4. Next to 'Stop capture after', enter the time after which the recording will automatically end (hours:minutes:seconds).



 

 

.
When the time comes, the recording will begin automatically. Before that, don't forget to set up the capture area and sound.
You do not need to press the 'REC' button for the recording to begin, however, please note that Movavi Screen Capture will
need to be running at the specified time. To ensure that, you can enable autostart in the Preferences.

Please note that if you haven't yet activated the program, the maximum capture time is two minutes for each video. To learn
more about activating Movavi Screen Capture, see the Activating Software section.
 
If you are starting a lengthy recording, make sure that you have enough free disk space for saving the temporary recording
files.

program_preferences.htm#general_preferences


 

 

Highlighting events
If you're making a video tutorial, it can be very helpful to draw attention to onscreen actions.
 
Highlighting the cursor
To show mouse actions in your video, you can choose to display a standard mouse, highlight the cursor, or use an effect for
mouse clicks.
How to highlight the cursor

Highlighted mouse and left click
Hiding the cursor
If you don't want to see the cursor on your recording, you can hide it so that it won't show up on the finished video even if
you move it over the capture area.
How to hide the cursor
 
Showing the keystrokes
If you're using keyboard shortcuts, you can display every key and key combination that you press on your video.
How to show keystrokes

The key combination will appear at the bottom of the video



 

 

Mouse cursor effects
Using mouse effects, you can use the mouse as a pointer and show your viewers where to click.
 
Show the mouse cursor

1. Click the mouse icon on the Movavi Screen Capture control panel to open the cursor options:  
2. In the Cursor options box, select the Show cursor option.
The cursor will now appear on your videos.
 
Highlight the mouse

1. Click the mouse icon on the Movavi Screen Capture control panel to open the cursor options:  
2. In the Cursor options box, select the Show cursor option if it is not yet enabled.
3. Select the Highlight cursor option.
4. To change the highlight color, click the square next to 'Highlight cursor' to open the palette and select a new color.
5. To change the diameter of the highlight, use the Size slider.
 
 
Highlight clicks

1. Click the mouse icon on the Movavi Screen Capture control panel to open the cursor options:  
2. In the Cursor options box, select the Show cursor option if it is not yet enabled.
3. Select the Highlight clicks option.
4. To the right of the 'Highlight clicks' option, you will see two color squares. Click the left or right square to
change the color for the left or right mouse button respectively.
 
 
Use a click sound

1. Click the mouse icon on the Movavi Screen Capture control panel to open the cursor options:  
2. In the Cursor options box, select the Show cursor option if it is not yet enabled.
3. Select the Mouse click sound option.
4. If you want to use your own sound effect, open the list and choose Add sound. Then, select the sound file that you want to
use.
 
Hide the mouse cursor
If you don't want to see the mouse cursor on your video:

1. Click the mouse icon on the Movavi Screen Capture control panel to open the cursor options:  
2. In the Cursor options box, disable the Show cursor option. The cursor will now be transparent in your videos, even
though you will be able to see it on your screen.
 
 



 

 

 



 

 

Recording keystrokes
If you're making a tutorial that uses keyboard shortcuts, it's helpful to display them on screen for your viewers. Enable
keystroke recording to show the keys you pressed at the bottom of the video.
 
To enable keystroke recording:

1. On the control panel, click the keyboard icon: .  The keyboard options panel will appear.
 
2. In the keystroke recording options panel, select one of the options:

• Keyboard shortcuts only — only key combinations such as Ctrl+C or Shift+Control+Esc will be shown on
screen. Letters and keys that do not cause an action will not be displayed. 

• All keystrokes — each key you press will appear on screen, including letters and numbers.

Once enabled, the keystroke recording icon should turn orange .

To turn off keystroke recording, click the keyboard button once again and disable the options. 

Tip: avoid entering any passwords or other sensitive information while you're recording a video with keystroke recording: if
you share the video, your viewers will be able to see each character you type.



 

 

Starting the recording
Begin recording
To begin recording screen activity, do any of the following:

• Click the REC button on the control panel.
• Use the start recording keyboard shortcut (F10 by default)
• In the system tray, right-click the icon  and choose Start Recording.

 

You will be given a 5-second countdown before recording begins.

Pause recording
To pause recording, do any of the following:

• Click the Pause button on the control panel.
•

Click the Pause button on the orange panel at the top of the capture frame: 
• Use the pause capture keyboard shortcut (F9 by default)
• In the system tray, right-click the icon  and choose Pause.

 
When you're ready to resume the recording, the Resume button will be in the same location as the Pause button.
 
To take a screenshot
To save a snapshot of the capture area, do any of the following:

•
Click the screenshot button on the orange panel at the top of the capture frame: 

• Press the screenshot keyboard shortcut (F8 by default).

Screenshots are saved to the folder specified in the preferences. By default, it will be the \Videos\Movavi Screen Capture
\Screenshots folder of your user directory.
 
Stop recording
When you're ready to finish the recording, do any of the following:

• Click the Stop button on the control panel.
•

Click the Stop button on the orange panel at the top of the capture frame: 
• Use the stop recording keyboard shortcut (F10 by default)
• In the system tray, right-click the icon  and choose Stop Recording.

 
The recording will end, and you can proceed to saving the output video.
 
If you want to terminate the recording without saving the video and delete the temporary recording file, click Cancel on the
main Movavi Screen Capture window.



 

 

Troubleshooting:
Windows style changes when I start recording
If you have a Windows Aero theme (Windows Vista, Windows 7), disabling the transparency effects will free more resources
and your computer will run faster during capture. The Aero theme will return once you have finished capture. To disable this,
open the Preferences and turn off the 'Disable Aero theme during capture' option in Video preferences.
 
Capture doesn't start immediately
By default, you will see a five-second countdown after you press the REC button and before the recording begins. You can
use this time to prepare for recording. If you want the recording to start immediately, open the Preferences and disable the
'Show countdown' option.
 
An orange panel appears on my recording
During recording, you can use the orange panel on top of the capture frame to take screenshots, pause or stop recording,
and keep track of the recording process. If you don't want this panel to appear on your videos, open the Preferences and
disable the 'Show capture control panel during recording' option.



 

 

Saving the captured video
When you end the recording, you will see a player with the captured video which you can preview before saving. If you want
to edit the video first, click the Edit button to open the video in the Video Editor application.
How to send captured videos to the Editor
 
Step 1: Choose a capture format
 
To save as a video file:
1. Click the 'Save as' box to open the list of output formats.
2. At the top of the list, click Video and audio.
3. Find the necessary format in the list and click on it to see more options.
4. Choose a video codec and resolution that you want to save the video with. To save the video without changing the
resolution, choose the item marked with 'Same as input'.
How to choose a resolution?
 
To save the video for a device:
1. Click the 'Save as' box to open the list of output formats.
2. At the top of the list, click Devices.
3. Find your device's manufacturer in the list and click on it to see more options.
4. Find your device's model and click on it to select it as the output format.
The format, resolution, and other media properties will be selected automatically to ensure compatibility with the selected
device.
 
To save only audio:
1. Click the 'Save as' box to open the list of output formats.
2. At the top of the list, click Video and audio.
3. Scroll down to find audio formats at the bottom of the list.
4. Find the necessary audio format in the list and click on it to see more options.
5. Choose the item with the bitrate that you want. Bitrate affects how much audio quality will be retained after saving. To
save with the original audio quality, choose the item marked with 'Same as input'.

Advanced settings

If you need to save the video with specific properties, click the cogwheel button  next to the 'Save as' box to manually edit
the media properties for video and audio.



 

 

 
Step 2: (Optional) Trim the video
If you have unwanted footage at the beginning or at the end of your video, you can trim it using the triangle markers  on
the player's progress bar. Click a marker and drag it towards the center of the progress bar to trim the video. After this, the
fragments outside the markers will not be saved.

 
 
Step 3: (Optional) Compress the video
At the bottom of the player window, you can see the estimated size of the output video. If you want to compress the video to
a smaller file size:
1. Click the estimated file size to open compression options.
2. In the file size box, drag the Quality slider left to decrease quality and file size. Keep an eye on the quality in the brackets
to make sure you don't set it too low.
3. Click Apply.
Learn more about compressing the video

Step 4: (Optional) Export the video
If you want to add the video to your iTunes library or share it on the web immediately after saving, you can do it using the
export options when saving the video.
 
Add to iTunes – select this option to add the captured video to your iTunes media library.
You will need to have iTunes 6.0 and above installed on your computer to use this feature. You can get the latest version of
iTunes from the official Apple page here.
 
Upload to – Click this option to open the list of available services and select the sites or hosting that you want to upload the
video to. Once saving is complete, the Share Online module will open, where you can prepare your files for uploading.
Learn more about uploading videos via Share Online
 
Step 5: Save the video

 
Editing the video
If you want to edit the captured video in Movavi Video Editor, click the Edit button in the saving video window.
Learn more about editing videos

http://www.apple.com/itunes/download/


 

 

Saving the video
If you want to go directly to saving the captured video, select the output format, and click Save to start processing the video.



 

 

Choosing a resolution
How to keep the original resolution
If you open the list of presets under Save as, you will see that some presets are marked with a specific resolution size, such
as 720p or 1080p. While these resolution sizes can help you easily scale your video if you've captured it using one of the
standard sizes, they may not be as effective if you've captured it using a custom capture area size.
 
To save your captured video with the original resolution, you will need to either choose a format from the General Video
group (located under Video and audio formats), or choose a format preset titled 'Same as input'.

 
How to avoid black bars
When you save or convert videos with a different aspect ratio (the ratio of the video's width to its height), the output file may
come out with black bars around it. This happens because a video of one size needs to be fit inside the new frame without
deforming the image itself. Just imaging fitting a rectangle inside a square and vide versa.

To solve this problem, you will need to either save the video without changing the resolution (see above), or change how you
want the video to be placed inside the frame. To do that, please follow these steps:
 
1. Choose a resolution size that you want in the preset list. To avoid losing quality, it should closely match the size of the
original video either in width or in height.

2. Click the cogwheel button  next to the Save as list to open settings for the chosen preset.
3. Find the Resize method list and open it. Here, you can choose the way your video will be fit inside the selected frame
size.

Letterbox is the default method that saves videos with the least distortion, but may add black bars in the region
around the video.
Stretch will literally stretch the original video to fill the whole screen, however, this may lead to visual distortions.
Crop will scale the video to fit the entire frame on the short side, cropping anything that does not fit. While some
parts of the video will be cropped, the objects inside the video will maintain their proportions.
Auto uses a combination of both stretch and crop methods.
 

Choose the most appropriate resize method depending on the content of your screencast. You can refer to the image in the
Settings window for a preview. Click OK to accept the changes and close the window.



 

 

Small resolution videos
For best results, choose a resolution size less than or equal to that of the capture area you used. Due to video compression
restrictions, If you save your video to a larger resolution, you will not get better quality, but the file size will be considerably
larger.
 
Setting a custom resolution
To set a resolution that is not included in the list of presets:
1. Choose a preset with the necessary format. You can choose any resolution at this point.

2. Next to the Save as list, click the cogwheel button  to open the settings for the chosen preset.

3. Enter the necessary frame size in the Width and Height boxes. Note the link button to the right of the Height box: .
By default, the width and height you enter will be adjusted to fit the selected proportions. Click the link button to disable
proportion constraining.
 
Please note that if you want to savmule videos for a mobile device, some devices may not support the new custom
resolution. For best compatibility, use the same aspect ratio and a smaller frame size than that of the device preset.



 

 

Reducing output size
Long recordings with a large capture area size may take up a lot of disk space. When saving the video, you can see the
estimated file size at the bottom of the player window. This shows approximately how large the ouput video will be after
saving with the currently selected format. 

Here are some things you can do to reduce the file size:
 
Use a smaller resolution
When you select an output format, choose a resolution that's slightly lower than the original video size. The resolution is
listed next to each output preset:

For example, changing the resolution from 1080p to 720p can reduce the video up to half the size. However, note that
resolution affects video quality, so setting a resolution too low can reduce its quality.

 
Compress the video
When saving the video, you can reduce the quality in order to achieve a smaller file size.
 
1. Click on the estimated file size at the bottom of the player window to open compression options.
 
2. Drag the Quality slider to the left to reduce the video's bitrate. Bitrate is the amount of data in each second of the video.
A slightly lower bitrate may not even be visible to the eye, but it can significantly reduce the file size. The text in brackets will
tell you if you've set the quality too low.
 
3. Click Apply to accept the changes.



 

 



 

 

Publishing videos online
You can upload the finished videos straight to social networks and file hosting folders using an additional module – Movavi
Share Online. Follow the steps below if you want to learn to upload your captured videos online.
 
Before you start:
If this is your first time uploading videos from Movavi Video Suite, you will need to download and install an additional module
(it's free!). Click here to download the installation file and then follow the instructions to install the software.
 
Step 1: Choose sites to upload
Before you save a video, click the Upload to option at the bottom of the player window and select the web sites or services
that you want to upload the video to. Please note that you will need to have an active account on the selected websites in
order to upload videos and that some services impose a length restriction.

Step 2: Save the video
Click the Save button to begin video processing. After the output video is ready, the Share Online module will open with your
file already in the upload queue. 
 
If you are using Share Online for the first time, you may be asked to provide your login details for the selected services. The
information you provide will be used only for authorization with the website so that Share Online can upload videos on your
behalf.
 
 
Step 3: Fill in the details
In the file list on the left, click your Screen Capture Project file to select it. The right-hand pane will display several
information fields for the selected video. Fill in the title, description, tags, etc. This will help the video sharing service to
categorize your video. Some services also allow you to set privacy settings.
 
Step 4: Upload the video
Click the Upload button in the bottom right-hand corner to begin uploading the video.
 

http://www.movavi.com/download-photo-video-uploader


 

 

Editing the captured video
After you've captured your screen, you can immediately send the video to Movavi Video Editor. To do that, click the Edit
button at the bottom of the player window:

Movavi Video Editor will open, and the video will be placed on the Timeline.

See also:
Cutting video in the Editor
Editing tools
Saving video in the Editor



 

 

Saving previously captured files
As your record onscreen videos, they are first stored as files with the *.mscproj extension. These files are located in the
directory you've specified in File Preferences, or in the default \Videos\Movavi Screen Capture\Projects folder. You can later
open these captured files and save them in the format of your choice.
 
To open the temporary files:
1. In the menu bar, open the Capture menu and select Open Captured File (Ctrl+O)
2. Select the *.mscproj file you want and click Open. You can now save the video just like after any other capture.

 

program_preferences.htm#file_preferences


 

 

Saving screenshots
You can save snapshots of any area of your screen, including videos playing in various media players.
 
Taking screenshots before capture:
1. Set up the capture area to include the part of your screen you want to take a snapshot of, or click the list of standard
resolutions and choose a variant youu need. For more information, please see the Capture Area section.

2. Take a screenshot:

•  Select Take a Screenshot in the Capture menu...
•  Or use screenshot shortcut key (F8 by default). You can change it to a custom key or key combination in

preferences.

3. In screenshot saving window choose a destination folder for screenshots, choose suitable file type from Files of type list
and finally click Save.
 
Taking screenshots during capture:

•  Select Take a Screenshot in the Capture menu,
• Or use screenshot shortcut (F8 by default). You can change it to a custom key or key combination in preferences.

 
After capturing video you will see a number of screenshots taken during capturing at the bottom of the saving window. You
can also click on the number to open screenshots folder. The screenshot destination folder can be changed in preferences.

Tip: if the main window is visible inside the orange capture area during capture (for instance, when
you capture fullscreen on a one-monitor personal computer), it will be visible on screenshots as well.

We advice you to minimize the main window during capture and use shortcut keys for taking screenshots..



 

 

Screen Capture preferences
 
To open the program settings for Movavi Screen Capture for Mac, open the Capture menu and select Preferences.

The preferences are organized into four categories: General, Files, Keyboard Shortcuts, Video, and Audio.
 



 

 

General preferences
The General tab allows you to change the interface language and set the folder where you want the captured files to be
stored by default.
 

 Select the Automatically check for updates option to make sure your Video Converter is always up-to-date. Minor
updates are absolutely free (for example, from v.1.3 to v.1.4). For major updates users with purchased Movavi Video Suite
license will get a considerable discount.
 

 Send anonymous usage stats to Movavi – checking this box will allow Movavi Screen Capture to send usage statistics
to our development team, enabling us to fix any bugs you may encounter much faster, as well as add new features that you
might be missing. The data sent by Movavi Screen Capture contains no personal information, will not be disclosed to third
parties and will be used for software improvement purposes only. You can find more information about usage statistics on
our Movavi Improvement Program page.
 

 Show countdown – with this option selected, whenever you start capture, recording will not begin right away, rather, you
will be shown a 5-second countdown to give you time to prepare.
 

http://www.movavi.com/mip.html


 

 

File preferences
The Files tab of Movavi Video Suite preferences allows you to manage the folders where you want Movavi Video Suite to
store its files. Click the arrow button next to a folder to set a different location.

Directory for captured files: where your output videos will be saved. After you save a video, this folder will open
automatically.
 
Directory for screenshots: if you take screenshots during capture, they will be saved to this folder.
 
Directory for temporary files:
When you record screen activity, Movavi Video Suite first writes your video as a temporary project file with the *.mscproj
extension. This file is stored in your Directory for temporary files until you save it as a video or audio file. Besides, you can
always open a project file and resave it in a different format.
 
By default, the files are stored even after you save the video, in case you want to reuse the temporary file and save it
to a different format, however you can delete all temporary files by clicking the trash can icon next to the Directory for

temporary files .
 

 Delete temporary video files after conversion – with this option selected, the temporary files will be deleted
immediately after you save the videos. This will help you save disc space, however you will not be able to save the recording
in a different format afterwards.
 
Directory for screenshots: when you take screenshots during capture, they will be saved to this folder.
 
Default screenshot format: when you take a screenshot, it will be saved with the selected format.

 
 



 

 

Keyboard shortcuts
The Keyboard Shortcuts tab allows you to set your own custom shortcuts for such actions as starting or pausing the
capturing process. On the left you can see keyboard shortcuts for every action.

To change one of the shortcuts:
 
1. Click inside the box with the shortcut you want to change. The box will become blank.
2. Simultaneously press on keyboard the keys you want to use as a shortcut to the selected action. The box will now display
your custom shortcut.
3. Click OK to apply the changes. To reset all the keyboard shortcuts to their original state, click the Reset to Default button.
 
In case you forget a shortcut, you can always look it up here in the keyboard shortcut settings.



 

 

Video preferences
The Video tab contains advanced video settings. If you need your videos in another format, we recommend that you save
them in the necessary format after capturing. Please see the Saving video section for more details.

Codec: the codec which will be used for capturing videos. The H.264 codec is suitable for most video capturing scenarios.
 
Maximum capture frame rate: like in regular video, the frame rate will define how many frames will be captured
each second. A lower frame rate will result in smaller output size, however, the video may not turn out as smooth. The
recommended frame rate is 20-30 frames per second.
 
Output frame size: defines the dimensions of the captured video. Full size means that it will be captured "as-is", while other
frame sizes will result in some scaling to fit the captured area into the specified frame.
 

 
For example, if you are capturing a 1280x720 screen with a frame size of 480x320, the captured image will need to be
scaled down. Likewise, if the area you are capturing is smaller than the output frame size, the video will need to be scaled
up, which results in larger file size with no gain in quality.
 

 Enable SuperSpeed conversion – the SuperSpeed conversion method allows Movavi Video Suite to save your

recordings much faster if you select presets marked with the green SuperSpeed icon .
 
Setting custom video preferences allows you to save time if you intend to always capture videos in one format, but some
options like a higher frame rate and larger frame size will require more resources. We recommend that you keep the default
settings and convert your videos to the necessary format and frame size when saving.
 

 Enable Intel® hardware acceleration– if your computer is equipped with one of the latest Intel® processors, the

captured videos will save much faster if you select conversion presets marked with the blue Intel icon: 



 

 

 
For Windows Vista and Windows 7 users:

 Disable Aero theme during capture – if you are running Windows Vista or Windows 7, the transparency in the 'glass'
Aero theme is harder to process and may cause defects in the captured video, especially if you are using a slower computer.
With this option enabled, your theme will be switched to the Windows Simplified theme when you begin capturing. Once you
stop capture, the original theme will be restored.
 
For users of Windows 7 and lower:

 Use DirectX for capturing – try this option if you are experiencing problems capturing some program windows. In
Windows 8 and above, the capture method is chosen automatically and this option is unavailable.



 

 

Audio preferences
The Audio tab allows you to change the preferred audio quality, including the sample rate, number of channels, and bits per
second.

 



 

 

Capture video

Follow the steps below to record video from a camera that's connected to your computer.
 
Step 1: Connect the camera you want to capture from to the computer. Make sure that the system recognizes the device
and that it is working correctly.
 
Step 2: Open the Movavi Video Suite launcher window and click Capture from cameras, VHS, TV on the Video tab.

 
Step 3: In the Video capture device box, choose the camera you want to use for capture. Then, select the resolution and
frame rate. A larger resolution will be able to retain better quality, however, the video file size will be larger. A higher frame
rate is necessary for recording motion, while static scenes can be captured with a lower frame rate.
 
Step 4: In the Audio capture device box, choose the microphone that you want to record the sound with.



 

 

Step 5: (Optional) By default, the recordings will be saved to your Movavi Library folder. If you want to save them

somewhere else, click the folder button  under 'Save files to' and choose a different location.
 
Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up
the new file name template. 
 
Step 7: Click Start Capture to begin recording the video. During capture, you can take snapshots using the camera button

 on the right.
 
Step 8: To finish the recording, click Stop Capture. If you need to record more videos, repeat steps 7 and 8.



 

 



 

 

Import AVCHD

Follow the steps below to import previously recorded videos from an AVCHD camera.
 
Step 1: Connect the camera you want to capture from to the computer, and enable USB connection mode on your camera.
Make sure that the system recognizes the device and that it is working correctly.
 
Step 2: Open the Movavi Video Suite launcher window and click Import AVCHD on the Data tab.

 
Step 3: In the Video capture device box, select your AVCHD camera.



 

 

Step 4: On the left, you will see a list of all clips on the camera storage. Review the files and deselect the ones you don't
need.

Step 5: (Optional) After importing, the files will be saved to your Movavi Library folder. If you want to save them somewhere

else, click the folder button  under 'Save files to' and choose a different location. 
 
Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up
the new file name template. 
 
Step 7: Click Export files to start copying the files. This may take a while depending on the size of the videos.



 

 



 

 

Capture audio
Step 1: Connect a microphone
Connect a microphone to your computer and make sure that it is recognized by the system.
 
Step 2: Open the audio recording module
Open the Movavi Video Suite launcher and click Record sound. The audio recording module will open in a separate
window.

Step 3: Set up audio capture
In the Audio capture device box, choose the microphone or whichever device you want to use for recording sound. To
record audio that is playing on your computer*, choose 'Stereo Mix' or 'Speakers'.
* Depending on the model of your audio card, this option may be named differently. Some device manufacturers do not
include a system audio recording option.
 
In the Saving captured files section, you can choose a template for naming the captured files. To do that, open the File
renaming box and choose date or free text. Then, fill in the template details and the recordings will all be named after this
template.
 
Under Save files to, specify the folder where you want to save the recordings. Click the folder icon next to the box to browse
for the folder you need.



 

 

Step 4: Record
Click Start Capture to begin recording. As you record sound, you can see the frequencies reflected as color bars in the
center. When you're done, click Stop Capture. If you need to record more audio clips, simply repeat this step.
 
The audio files will be saved to the folder specified in the 'Save files to' box. To open this folder, click the View saved files
button. 



 

 

Split video
Split Video is an extra video editing module that allows you to quickly cut videos into parts and cut out unnecessary bits like
commercials.

 
Not sure where to start? Read the quick start guide

How-to's:
Cut out parts

Split video into several files
 
How do I open the split video module?
To open the split video module, click Split Video in Movavi Video Suite launcher on the Video tab.



 

 

How to split video

The splitting module allows you to quickly split a video file into parts or cut out fragments without reconverting the file or any
quality loss.
 
Step 1: Launch the splitter
In the Movavi Video Suite launcher, click Split video on the Video tab.

Step 2: Open a video
At the bottom of the window, click Add file and choose the video you want to split. Or you can just drag-and-drop a video
from Windows Explorer.

Step 3: Split the video
Use the Split tool to mark scene borders.
 
1. Place the position marker onto the moment where you want to split the video. To precisely mark the right moment, zoom in
on the timeline or use the buttons in the player to skip one frame forward or backward.
 



 

 

2. Click the Split button. A black line will appear on the Timeline, marking the edge of the scenes. A new scene will appear in
the Resulting clips column.
 
Repeat this step if you need to split the video into more scenes.

Step 4: Deleting unwanted scenes
Now that you've split the video into scenes, you can remove unwanted fragments.
 
1. Select the unwanted scene on the Timeline or in the Resulting clips column.
 
2. Press the Delete key on your keyboard. The scene will be marked as unwanted and will be cut out of the video.
 
Step 5: Saving the result
If you want to save all the scenes you've split into separate files, click the Split button.
If you want to save all the scenes together into one file, cutting out the unwanted scenes, click Join.

 



 

 

Opening files
Drag a file from Windows Explorer onto the splitter window...

Or click Add file in the splitter window and then find the file you want to split.



 

 

Cut out parts
Use the Split video module to delete unwanted parts from a video.
 
Step 1: Add File
To add a video file for editing, do any of the following:

• Drag-and-drop a video file onto the Split Movie window
• Click the Add File button at the bottom, choose the file in the Open Video dialog box and click Open.

Your file will be loaded onto the Timeline. When you open a file, it will start out as one 'good' scene. From here, you can split
the video or mark the scenes you want to discard.

 
Step 2: Mark the scenes you want to keep
In this step, you will need to specify which scenes of the video you want to keep. For your convenience, you can do this
using a number of ways listed below. For better precision, zoom in using the Zoom slider in the right part of the toolbar.
 
Selected scenes, ones that will be saved in the output file, are marked on the Timeline and progress bar in orange. Parts of
the video that will be discarded are marked with gray.

Using the Select and Deselect buttons
For a quick selection, use the Select and Deselect buttons on the toolbar.
1. Place the position marker on to the beginning of the scene.

2. Hold down the Select button:  to mark a good scene. The video will be slowly played back, marking the part as
a good scene.



 

 

3. Hold down the Deselect button  to mark a bad scene. The video will be slowly played back, removing the selection
from this scene as the progress marker moves.
 
Using Bracket markers
 
1. Place the position marker at the beginning of the scene.

2. Click the Left Bracket button  to mark the scene's beginning.
3. Move the position marker to the end of the scene.

4. Click the Right Bracket button  to mark the end of the scene.
 
Step 3: Save the result
If you've opened Split Movie from the Edit Video application, simply click OK to go back to editing the file. You can find the
split scenes on the Media tab.
 

• If you want to save the selected scenes each to a separate file, click the Split button.
• If you want to save all the selected scenes to one file without the grey parts, click the Join button. 

 
The file will be split. If you've been working on a very large file, processing may take up to a minute. By default, the files will
be saved to your \Videos\Movavi Library folder, but you can change the output folder in the Preferences.



 

 

Split video into parts
Splitting scenes will allow you to save each scene as a separate file.
 
Step 1: Add File
If you've opened Split Movie from the Edit Video application, the file will already be opened for you.
 
To add a video file for editing, do any of the following:

• Drag-and-drop a video file onto the Split Movie window.
• Click the Add File button at the bottom and then choose the file in the Open Video dialog box.

Your file will be loaded onto the Timeline. When you open a file, it will start out as one 'good' scene. From here, you can split
the video or mark the scenes you want to discard.
 
Step 2: Mark the scene's borders.
1. Place the position marker to where you want to split the scene. Note that the position marker must be on an orange part of
the Timeline for the Split button to become active.

2. Click the Split button  on the toolbar to add a scene border. A black line will appear on the Timeline, denoting
the border.
 
3. If necessary, repeat these two steps for the end of the scene and to split the file into more scenes.



 

 

Step 3: Save the result
When you're done, click the Split button in the bottom right-hand corner to save the scenes to separate files.



 

 

Editing scenes
Changing scene borders
 

• Hold your mouse over a scene border and drag it left or right, depending on which part you want to change.

•

Use the frame navigation buttons (  and ) in the player to precisely move the progress marker and click one of

the Bracket markers (  and ) to mark the scene's new beginning or end.
    

• In the Resulting clips section, select the scene you want to edit. Then, click the beginning or end timestamp and type the
new time for the scene's borders.

Merging Scenes
To merge two or more scenes into one contiguous scene:
1. Select the scenes you want to merge on the Timeline or in the Resulting clips column. Hold Shift to select multiple
scenes.



 

 

2. Click the Merge button on the toolbar, and all of the selected scenes (as well as any non-selected scenes between them)
will be marked as one single scene.

Merge button
 

 >>> 
 
Adding a good scene
Right-click on the timeline where you want to add a new scene and select Add a Good Scene from the context menu. A
1-second fragment will be marked as selected. Then, drag the edges of the scene with the mouse to change the scene's
length.
 
When you've selected a scene, it will be marked orange on the Timeline and the progress bar, and the scene will be added
to the scene collection in the Resulting clips pane on the right.
 
Inverting scene selection:
The Invert button allows you to invert the selection for the entire file, selecting grey scenes and deselecting the good
scenes. This allows you to quickly mark short fragments for deletion, when you can simply select the fragment (for example,
an advertisement), and then invert the selection so that the advertisement is marked for deletion. 

The Invert button
 
Deselecting scenes:
 

• Find the scene in the Resulting clips pane on the right, right-click on the scene, and choose Delete.
 

• Place the position marker at the beginning of the fragment you want to deselect and hold down the Deselect  button.

The Deselect button
 

• Click the scene's orange bar on the Timeline or the progress bar to select the scene, and then click the Delete button on
the toolbar.



 

 

The Delete button
 
Deleting Scenes
1. Select the scene you want to delete in the Resulting clips column or on the Timeline.
2. Press the Delete key on your keyboard, or right-click the scene and choose Delete from the pop-up menu.
 
Resetting scene selection:
If you want to start over, right-click in the Resulting clips section and select Delete All. This will deselect all parts of the

video. If you would rather start with the whole video selected, click the Invert  button to select the entire track.
 
Moving Scenes
If you want to keep the duration of the scene, but change its position on the Timeline, simply click and drag the scene's
orange ribbon on the Timeline.



 

 

Settings
To open the settings for the splitting module, click Settings in the menu.
 

Language — choose your preferred interface language.
 

Destination folder — click the folder icon  to choose a different folder for saving the output videos.
 Always use this path — select this option to always save videos to this folder. Otherwise, you will be prompted to

choose a destination folder every time you split a video.
 

 Play notification sound after splitting — a sound will be played after splitting is complete. This may come in handy if
you're splitting very large files.
 

 Overwrite existing files — if a file with the same name is found in the output folder, the new file will replace it.
 



 

 

Watch video and audio
With the Movavi Video Suite player, you can play video and audio in any format without having to install any additional
codecs or software.
 
Opening files
To open video or audio files, click the buttons in the bottom right, under the playlist.
+ File to open individual files
+ Folder to open all the files in a folder
+ DVD to select a disc with videos. You will need to find the VIDEO_TS folder on the disc.
 
Or you can simply drag any files you want to play right onto the player window.

Playlist
The playlist displays your media queue. If you want to jump to another item, double-click it in the playlist to play. To show or
hide the playlist, click the list button on the toolbar.



 

 



 

 

Burn files to disk
With the Burn Disc application you can burn videos to DVDs, create audio CDs, copy discs and burn any kinds of data to a
CD, DVD or Blu-ray.

How-to's:
Burn videos to DVD
Burn an audio CD
Burn data to disc

Burn ISO image to disc
Copy disc to disc

Rip disc to hard drive
 

Step 1: Add Files
1. In the Video tab of the Movavi Video Suite launcher, click Burn CD, DVD, Blu-ray to open the Burner module. The
ChilIBurner module will open.
2. Drag and drop the files you want to burn from Windows Explorer onto the ChilIBurner window to add them to the disc
queue.
 
Step 2: Choose Disk Type
1. In the Mode section on the right, choose the type of disc that you have. Disc type and capacity should be printed
somewhere on the disk itself or on its packaging.
2. Then, choose video options for the selected disc type.
 

NTSC or PAL – select the TV standard depending on the DVD player you have or the country you live in.

• NTSC is used in North and Central America, most countries of South America (excluding Argentina and
Brazil), Burma, Japan, the Philippines, South Korea, Taiwan, and Vietnam.



 

 

• PAL is used in all countries of Africa, Europe, Oceania, and the Middle East, most Asian countries, as
well as in Argentina, Brazil, Paraguay, Uruguay, and French Guiana

 
Quality – this parameter affects video and audio bitrate. Higher quality requires more disc space.
 
Aspect ratio – the ratio between the width and height of the video's frame. 4:3 is the standard format used for TV,
while 16:9 is used for widescreen movies.

 
Disc type – select DVD if you have a regular DVD disc, or DVD DL if you have a double-layer DVD (it should be
written somewhere on the package your DVD came with).
 
DVD menu template – select a graphic DVD menu, which is the first thing you see when you open a disc on your
player, and where you can select which file to play. 

 

Step 3: Burn Disc
1. Check the disc capacity scale at the bottom. If the blue line crosses into the red, it means that there is not enough space
to fit all of the added files. In that case, you can either set a lower quality, or write some of the files to another disc.

Disc capacity scale
 

2. In the upper right-hand corner of the window, enter a name for the disc. It will show up in My Computer when you view all
your drives.
3. Make sure that a writable disc of the selected type is inserted into the drive, and your hardware supports disc writing. 
4. Click Burn Disc to begin recording the files to disc. This may take a few minutes.



 

 

How to open the burning module
 
Burn audio:
In the Movavi Video Suite launcher, click Burn audio to CD on the Audio tab.

Burn CD/DVD/Blu-ray video:
Click Burn disc on the Data tab.

Burn ISO to disk:
Click Burn image to disc on the Data tab.



 

 

Copy disk to disk:
Click Copy disk to disk on the Data tab.

Copy disc to computer:
Click Copy disk to hard drive on the Data tab.



 

 

 



 

 

Burn a video DVD
Step 1: Open the Burn Disc application in Video mode
1. Click Burn disc on the Data tab of the Movavi Video Suite launcher app.
2. The Burn Disc application will open. There, click on the Video tab at the top.
 
Step 2: Choose your disc type
In the Mode section of the right-hand column, choose DVD mode.

Step 3: Add the files you want to burn

• Drag-and-drop files onto the ChilIBurner window, or
•

In the bottom left-hand corner, click the plus icon  to add a file, or the folder icon  to add the contents of one or more
folders to the list.

 
 
Step 4: Set up your disc preferences
Set the following preferences in the right-hand part of the window:
 



 

 

Disc name – located at the very top of the panel. You will see this as the name of the disc drive when you insert the DVD
into your computer or DVD player.
NTSC or PAL – select the TV standard depending on the DVD player you have or the country you live in.

• NTSC is used in North and Central America, most countries of South America (excluding Argentina and Brazil), Burma,
Japan, the Philippines, South Korea, Taiwan, and Vietnam.

• PAL is used in all countries of Africa, Europe, Oceania, and the Middle East, most Asian countries, as well as in Argentina,
Brazil, Paraguay, Uruguay, and French Guiana

 
Quality – this parameter affects video and audio bitrate. Higher quality requires more disc space.
Aspect ratio – the ratio between the width and height of the video's frame. 4:3 is the standard format used for TV, while 16:9
is used for widescreen movies.

 
Disc type – select DVD if you have a regular DVD disc, or DVD DL if you have a double-layer DVD (it should be written
somewhere on the package your DVD came with).
DVD menu template – the DVD menu is the first thing you see when you open a disc on your player, and where you can
select which file to play. The ChilIBurner module allows you to select and customize professional-looking DVD menus.
By default, only one theme will be available, but you can select Download More Themes from the list and download
additional themes from our official website. If you want to customize or preview the selected theme, click Edit. You will see
the following window:



 

 

Here, you can set the time for the previews of each video and change the music that will play in the menu. Click OK to apply
the changes.
 
Step 5: Burn disc
At the bottom of the ChilIBurner window, there is a disc capacity scale. The blue line reflects how much of the disc you will fill
when you record the videos, while the yellow and red lines display the maximum capacity of the selected disc type.

Make sure that you have not exceeded the disc capacity. To free up some space, you can delete files from the list or slightly
reduce quality.
Then, check that you have a writable DVD in your DVD drive and click the Burn Disc button to begin the burning process.
Your disc will be ready in a few minutes.

 



 

 

Burn an audio CD
Step 1: Open the Burn Disc application in Audio mode
Click Burn audio to CD on the Audio tab of the Movavi Video Suite launcher app.
 
Step 2: Choose audio disc type
In the Mode section of the right-hand column, choose Audio CD or MP3 CD mode. Standard audio CDs usually fit about an
album's length of music, but can retain quality very well, while MP3 CDs allow you to record several folders of audio files to
one CD. Please note that not all CD players support MP3.
 
Step 3: Add the files you want to burn

• Drag-and-drop files onto the ChilIBurner window, or
•

In the bottom left-hand corner, click the plus icon  to add a file, or the folder icon  to add the contents of one or more
folders to the list.

 
Step 4: Set up your disc preferences
On the right panel of the ChilIBurner interface, set the following preferences:
 

Disc name – located at the very top of the panel. You will see this as the name of the disc drive when you insert the disc into
your computer or Blu-ray player.
 
Disc type – select CD if you have a regular CD Disc, or Mini-CD if you have a CD of smaller size (8 cm or 3.1 inches in
diameter versus the standard 12 cm or 4.7 inch CDs).
 
Quality – if you select MP3 CD mode, you can set the quality of the audio files. Higher quality files have higher bitrate, but
take up more space. If you select Audio CD mode, the best quality will automatically be selected. 
 
Step 5: Burn disc
At the bottom of the ChilIBurner window, there is a disc capacity scale. The blue line reflects how much of the disc you will fill
when you record the videos, while the yellow and red lines display the maximum capacity of the selected disc type.



 

 

Make sure that you have not exceeded the disc capacity. To free up some space, you can delete files from the list or slightly
reduce quality for MP3 files.
Then, check that you have a writable CD in your disc drive and click the Burn Disc button to begin the burning process. Your
disc will be ready in a few minutes.



 

 

Burn data to disc
Step 1: Open the Burn Disc application in Data mode
Open the Movavi Video Suite launcher application and click Burn disc on the Data tab.

 
Step 2: Add the files you want to burn

• Drag-and-drop files onto the ChilIBurner window, or
•

In the bottom left-hand corner, click the plus icon  to add a file, or the folder icon  to add the contents of one or more
folders to the list.

 
Step 3: Set up your disc preferences
On the right panel of the ChilIBurner interface, set the following preferences:
 

Disc name – located at the very top of the panel. You will see this as the name of the disc drive when you insert the DVD
into your computer or DVD player.

 
Disc type – select the type of recordable disc that you have. Disc capacity is listed in parentheses. If you are not sure if you
have a double-layer (DL) DVD or Blu-ray™ disc, check the package that it came with. 
 
Step 4: Burn disc
At the bottom of the ChilIBurner window, there is a disc capacity scale. The blue line reflects how much of the disc you will fill
when you record the videos, while the yellow and red lines display the maximum capacity of the selected disc type.

Make sure that you have not exceeded the disc capacity. To free up some space, you can delete some files from the list or, if
you are recording video and audio files, use the conversion module to compress them.
Then, check that you have a writable disc of the selected type in your drive and click the Burn Disc button to begin the
burning process. Your disc will be ready in a few minutes.



 

 

Please make sure your optical drive supports recording to the selected type of disc.



 

 

Burn ISO to disc
The Burn Disc module can help you burn disc images with the .iso extension to an optical disc.
 
Step 1: Open the Burn Disc application in Copy mode
1. Open the Movavi Video Suite launcher and click Burn image to disc on the Data tab.
2. In the Burn Disc application, open the Copy tab.

 
Step 2: Select the image
Click the Browse icon  next to the Source list to browse for the .iso file you want to burn.
In the Destination list, select the drive you want to use for recording. If you have only one DVD-RW drive, it will be selected
automatically.
 
Step 3: Start burning
Check that you have a writable disc in the optical drive and click Burn Disc to begin burning your ISO file to disc.



 

 

Copy disc to disc
If you have two CD/DVD drives:
Step 1: Insert the discs
Insert the disc you want to copy into one of the drives. If only one of your CD/DVD drives can burn discs of this type, insert
the disc into the read-only drive (i.e. CD-R or DVD-R drive).
Then, insert a recordable disc into the other CD/DVD-RW drive. If you are using a CD/DVD-R disc, make sure that is hasn't
already been recorded to.
Please note that Movavi Video Suite is not intended to make illegal copies of copyrighted software. Some CDs and DVDs
may be copy-protected and cannot be copied or ripped to hard drive.
 
Step 2: Open the Burn Disc application in Copy mode
Open the Movavi Video Suite launcher and click Copy disc to disc on the Data tab.
 
Step 3: Set Source and Destination
In the Source list, select the drive with the disc you want to copy. If you cannot see the drive in the list, make sure that the

CD/DVD you want to rip is inserted into the drive and click the orange refresh icon  to its right.
In the Destination list, select the drive with the empty disc.
 
Step 4: Start copying
Click Burn Disc to begin copying data from one disc to another.

If you only have one CD/DVD-RW drive:
1. Save the contents of the disc as an ISO.
2. Burn the ISO file to disc.
 



 

 

Copy disc to hard drive
Step 1: Insert the disc
Please note that Movavi Video Suite is not intended to make illegal copies of copyrighted software. Some CDs and DVDs
may be copy-protected and cannot be copied or ripped to hard drive.
 
Step 2: Open the Burn Disc module in Copy Disc mode
Open the Movavi Video Suite launcher application. In the Data tab, select Copy disc to hard drive. The Burn Disc module
will open.
 
Step 3: Set Source and Destination
In the Source list, select your CD/DVD drive If you cannot see the drive in the list, make sure that the CD/DVD you want to

rip is inserted into the drive and click the orange refresh icon  to its right.
In the Destination list, select Browse folder and specify the location where you want to save the disc files.
 
Step 4: Start copying
Check that you have enough disc space to copy the disc and click Burn Disc to begin copying disc files to your hard drive.

 



 

 

Uploading files to the web
When you're done creating and editing your videos, surely, they deserve to be shared with your friends and maybe with the
whole world! You're just a few steps from uploading the videos with the sharing module.
How do I upload files from the Converter module?
How do I upload files from the Screen capture module?
 
Before you start:
If you haven't used the sharing app before, you'll need to download and install it first:
 
Step 1:
Click Share photos online on the Photo tab of the Movavi Video Suite launcher.

Step 2:
A message will appear. Click Download in the dialog box.

Step 3:
The app will be automatically downloaded and installed in a few minutes. From then on, you can use the Share photos
online button to open the sharing app.



 

 

How to share files:
Open files
Upload videos to YouTube
Upload files to Facebook
Upload files to Amazon S3 storage
Upload files to FTP
Upload photos
Manage your accounts

 



 

 

Adding Media Files
Before you begin uploading your videos and files online, you will need to add the files to the queue. If you used the Upload
to the Web option in one of the Movavi Video Suite modules to open Share Online, the files will already be added to the
program, however you can always add additional files using one of the following ways:
 
1. Select the necessary files in a Windows Explorer window and drag them onto the Share Online window.

 
2. In the top part of the Share Online window, click Add File and browse for files you want to upload.

 
3. If you want to add all files within a folder, click Add Folder at the top of the window and select one or more folders in the
Browse dialog box.

 

Managing files on the list:

•
To remove a file from the list, click the  button to the right of it.

• If you want to temporarily exclude files from the upload queue, uncheck the box  to the left of the file. The file will remain
in the list, but will not be uploaded when you click the Upload button.

• To remove all files from the list, click Clear List at the top of the window.



 

 

Uploading Photos
Besides video and audio files, Movavi Video Suite can also help you upload photo albums.
 
Step 1: Add Files
1. In the Photo section of the Movavi Video Suite Launcher, click Share photos online to open the sharing module.

2. Drag-and-drop files from Windows Explorer onto the Share Online window or use the Add File and Add Folder buttons at
the top of the window, and specify the files you want to open.

Step 2: Choose Upload Destination
Using Share Online, you can upload your photos to several sites at once.
 
1. To select the services to which you want to upload your photos, click their icons at the bottom of the window.
* Note that YouTube does not accept photo uploads. Photos in the upload queue will still be uploaded to other selected
services.



 

 

 
2. If you're using a service for the first time, you will be asked to authorize with the website. Don't worry, your login data is
safe: where possible, authentication is processed through the website itself, so that your user data is not seen or stored by
Share Online.

Step 3: Add Descriptions
Now you can add some additional information about each file.
1. Click a file in the list. File Information fields will appear in the column on the right.
2. Fill in the title and description for the file. At the bottom of the column, you will see service-specific fields, such as privacy
options.

Step 4: Upload the Files
When you're ready, click the Upload button to begin sharing your photos. This may take up to a few minutes depending on
your Internet connection. 



 

 



 

 

Uploading Videos to YouTube
Follow the instructions below to upload videos to YouTube. You will need access to a YouTube or Google account to upload
the videos.
 
Step 1:
Click Share photos online on the Photo tab of the Movavi Video Suite launcher.

Step 2:
Add media files to the list or use the upload option in one of the Movavi Video Suite modules.
 
Step 3:
In the bottom part of the Share Online window, click the YouTube icon. You can also choose to upload to other services
simultaneously by clicking their icons.

Step 4:
If you have not yet logged in, the program will ask for your login data*. Enter your YouTube username and password into the
respective fields and click OK.



 

 

Step 5:
In the file list, click on a file to select it. The right part of the window will display a number of fields. Here, you can fill in some
information about your video:

• Add an eye-catching name and description that will be displayed on the video's page on YouTube.
• Add a few tags describing the videos and select a relevant video category: this will help other users find your video.
• Define privacy settings: public will mean that any YouTube user can find your video, while private videos can only be

seen by your friends and people that you send a link to. 
• Check the length information. As per YouTube limitations, only verified accounts are allowed to upload videos longer than

15 minutes. For details on verifying your account and increasing your upload limit, please see Google's official support
page.

Repeat step for all files in the list.

Step 6:
When you're ready, click Upload to start uploading your files to the selected services. 

https://support.google.com/youtube/answer/71673?hl=en
https://support.google.com/youtube/answer/71673?hl=en


 

 

*Your data will only be used for authentication with the selected services and never transferred to third parties.



 

 

Uploading Videos to Facebook
You will need access to a Facebook account to upload videos and other content via the Share Online module.
 
1. Add media files to the list or use an export option in one of Movavi Video Suite modules.
 
2. In the bottom part of the window, click the Facebook icon. You can also select other services if you want to simultaneously
upload files to them.

3. If you have not yet authenticated with Facebook, you will see a login window appear. Enter your Email and password and
click Log In. If you don't want to sign in every time, check Keep me logged in to Movavi Share Online.

4. In the file list, click a file to select it. You will see some fields appear in the right pane. You can use these fields to add a
name and description, as well as assign a number of tags to make your video easier to find. Please check the length of each
video, as Facebook does not allow videos longer than 20 minutes. You can still split long videos into multiple files using the
Split Movie or Video Editor module and upload them together.
Repeat this for all your files.
 
5. When you are ready, click Upload to begin uploading your files. Soon, they will appear on your Facebook page.

 



 

 

Uploading Videos to Amazon S3
You can use the Share Online module to upload files to your Amazon S3 storage.
 
Step 1. Add files to the program or use an export option in another Movavi Video Suite module.
 
Step 2. In the Upload to panel at the bottom of the window, click the S3 icon to select Amazon S3 as the upload server.
You can select more than one upload destination.

Step 3. If you have not yet provided your Amazon S3 credentials, you will be asked for them now. Enter the necessary
information and click OK.

Step 4. (Optional) In the file list, click a file to select it. You will see some fields appear in the right side of the window. You
can use the fields to provide some information about the uploaded files. You will need to do this for each file separately.



 

 

Step 5. To begin sending the files to the server, click Upload.



 

 

Uploading videos to FTP
The Share Online module of Movavi Video Suite also supports FTP file uploads.
 
1. Add your files to the list or export them for sharing online via another Movavi Video Suite application.
 
2. In the bottom panel, click the FTP icon to select FTP as the upload service. You can also choose other services along with
FTP to upload files to them as well.

3. If you haven't yet entered your FTP server information in account preferences, you will be asked for it now.

4. (Optional) Select a file in the file list. You will see its information appear on the right. Here, you can fill in more information
about it and specify a folder where you would like to upload the file. Repeat this for all other files.



 

 

5. Click Upload, and your files will be sent to the FTP server. 



 

 

Accounts
To upload media files to a web site or a hosting service, you will need to provide your login credentials, such as a login and
password, to allow Share Online to upload the files on your behalf. Your account data is stored by Share Online so that
you will not have to re-enter it the next time you upload files to that service. The data is only used for authorization with the
services you choose and is not sent to any other parties.
 
To view information about saved accounts:
1. In the upper right-hand corner of the Share Online window, click Preferences.
2. A Preferences window will open. Click the Accounts tab at the top.

 
Here, you can manage saved accounts, log in to services, and erase account data. You can check the username listed
under a service to see which account you are logged in as.
 
3. To clear saved account data, click the Disconnect button next to the service. Next time you select this service, you will be
asked to authorize again. You can also use the Disconnect button if you want to log in to a different account.

 



 

 

Help and support
If you have any questions or concerns regarding Movavi software, you are welcome to contact our support team. 
 
Write to us at suppport@movavi.com
or click the button on the right to ask a support specialist via live chat.
 
Please describe your problem in as much detail as possible; any screenshots or log files will allow us to help you faster. Our
support team specialists may ask you for additional information that is required to solve your problem: these may include
your license key, log files, and files you were working with, but never personal information. We value your privacy!
 

Have you checked the FAQ section?
Your question may have already been answered!

 
Frequently asked questions:
How to remove trial restrictions?
Why do my videos have "trial version" on them
What are the system requirements for running Movavi Video Suite?
What formats can I save my videos in?
How to update the graphics card drivers?

mailto:support@movavi.com
http://www.movavi.com/support/#sales


 

 

System requirements
 Minimum system requirements Recommended configuration
Operating system Windows XP*/Vista/7/8/10 with latest service packs and patches
Processor Intel, AMD or compatible processor,

1.5 GHz
Intel, AMD or compatible processor, 2.8
GHz and above

Graphics card NVIDIA® GeForce™ series 6 or higher, AMD Radeon™ R600 or higher
graphics card with up-to-date drivers**

Resolution 1024x768, 32-bit color 1280x1024 or higher

RAM Windows XP – 512 MB
Windows Vista, 7, 8, 10 – 1 GB

Windows XP – 1 GB
Windows Vista, 7,8, 10 – 2 GB

Available disk space 850 MB for installation
2 GB for ongoing operations***

10 GB

 Administrator permissions are required for installation
Additional features:  Sound card for audio recording and

playback
  Intel® hardware acceleration requires

a compatible Intel processor supporting
Intel HD Graphics™ 2nd generation or
higher
Learn more

  For intended performance, make sure
that your graphics card drivers are up-to-
date.
Updating graphics card drivers

 
* Windows XP does not support recording system sound simultaneously with audio devices.
** Your graphics card must support OpenGL for the program to run correctly.
*** Free disk space is required to save the temporary recording file and the output video. The required amount of disk space
will depend on the resolution, format, and length of your videos.
 
 
Movavi Video Suite may also run on slower machines, however, we cannot guarantee stable performance if the minimum
requirements are not met.

program_preferences.htm#video_preferences


 

 

Supported formats
 

 
Video formats

Input Output  
Supported codecs

3GPP (.3gp), 3GPP2 (.3g2) H.263, H.264, MPEG-4

ASF (.asf)  MPEG-4, VC-1, WMV V7

H.264, MPEG-4, MJPEGAVI (.avi)

 DivX, Xvid, DV, Cinepack, Fraps, TechSmith, Без сжатия

DivX Video (.divx)  DivX

DVD  

FLV1, H.264

 VP6, H.263, Flash Screen Video

Flash (.flv, .swf)

 MJPEG

H.264, MPEG-4, MJPEG, Theora, VP9Matroska (.mkv)

 DV, Без сжатия

MPEG Transport Stream (.m2ts) MPEG-2, H.264

MPEG Transport Stream (.ts, .mts, .m2t)  MPEG-2, H.264

MPEG (.mpg, .vob) MPEG-1, MPEG-2

MPEG
(.mpeg, .mpe, .m1v, .dat, .mod, .tod, .vro)

 MPEG-1, MPEG-2, H.264

MPEG-4, H.264MPEG-4 (.mp4)

 H.263, MJPEG, ProRes

MPEG-4 (.m4v)  MPEG-4, H.264, H.263, MJPEG, ProRes

MXF – Material eXchange Format (.mxf)  MPEG-2, DV

TheoraOGV – Ogg Video (.ogv)

 MPEG-4

H.264, MPEG-4, MJPEGQuickTime (.mov)

 AIC, ProRes, Sorenson 1/3, PNG

QuickTime (.qt)  H.264, MPEG-4, AIC, MJPEG, ProRes, Sorenson 1/3

RM (.rm, .rmvb)  Real Video 2/3/4, Cooker

VP8, VP9WebM (.webm)

 VP7

WMV V8WMV – Windows Media Video (.wmv)

 WMV V7, WMV 9, WMV 9 Screen, WMV 9 Advanced profile,
MPEG-4, WMV 9.1 Image V2

WTV (.wtv)  H.264, MPEG-2

 
Video formats

Input Output  
Supported codecs

AAC – Advanced Audio Coding (.aac) AAC

AIFF (.aif,.aiff)  AIFF

APE – Monkey's Audio (.ape)  Monkey's Audio

Au (.au, .snd)  WAV

FLAC – Free Lossless Audio Codec (.flac) FLAC

MP3 – MPEG-1/2 Audio Layer III (.mp3) MP3



 

 

MPEG-4 (.m4a) AAC, ALAC

MPEG-4 ( .m4b)  AAC, PCM

Opus (.opus)  Opus

OGG – Ogg Audio (.ogg) Vorbis

PCMWAV – Waveform Audio File Format (.wav)

 AAC, MP3

WMA – Windows Media Audio (.wma) WMA 9

  WMA Pro, WMA Voice

Форматы изображений Input Output  
APNG (.apng)   

BMP (.bmp)  

DPX (.dpx)   

GIF (.gif)  

JPEG (.jpg)  

JPEG (.jpeg, .jpg, .jp2, .jls)   

Форматы Netpbm (.pgm, .pbm, .ppm, .pam)   

PCX (.pcx)   

PNG (.png)  

PTX (.ptx)   

SGI (.sgi)   

TARGA (.tga)   

TIFF (.tiff)  

WebP (.webp)   

XBM (.xbm)   

XWD (.xwd)   
 



 

 

Updating graphics card drivers
If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from
your graphics card manufacturer's website and install it on your system. Some graphics card drivers also have a useful utility
that notifies you when a driver update is available and updates the driver automatically. Keeping your graphics card drivers
up-to-date will ensure stable performance of applications and games on your computer.
 
Step 1: Find your graphics card manufacturer
1. Right-click your desktop and choose Screen Resolution
2. In the Screen Resolution settings window, click Advanced settings.
3. This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the
Adapter Type section. Note the full name of the graphics card somewhere for later.
 
Step 2: Download the new version
Now that you've learned your graphics card manufacturer and model, go to the manufacturer's website and find driver
downloads. There, look for the model or series that you've found earlier and download the driver installation file. Some
manufacturers may also offer a utility that will automatically find the necessary driver.
NVIDIA download center
AMD download center
 

Warning:
Only download drivers from the official manufacturer's website. Third-

party websites offering driver downloads may contain malware.
 
Step 3: Install driver
Once the file is completely downloaded, run the installation file and follow the onscreen instructions to install the driver on
your system. Your display may blink several times in the process. After the installation has finished, it is advised that you
restart the computer.
 

 
Updating NVIDIA® Driver
Modern NVIDIA graphics cards come with a special application called NVIDIA GeForce™ Experience that monitors driver
updates and allows you to optimize your computer's graphics performance.
 
1. Open the NVIDIA GeForce Experience application. It should already be installed on your system. If you cannot find the
application, please try the method above.
2. In the Drivers section, click the Check for updates button to find the latest drivers.
3. When the application has found a newer driver, click the Download driver button. From here, the software will
automatically download and install the necessary driver for your system.

http://www.nvidia.com/Download/index.aspx?lang=en-us
http://support.amd.com/en-us/download


 

 

Updating AMD® or ATI® Driver
 
1. If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD's official website.
AMD Driver Download Center
 
2. Download the auto detect utility and run it when the download has finished. 
Download Auto Detect Utility
 
3. The utility will then automatically find your graphics card and help you download and install the right driver for your
system.
 
If the utility fails to find a driver for you, you can manually select your graphics card model and operating system on the
Driver Downloads page and download the driver.
 
4. After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.
 
5. After the driver has been installed, it is recommended that you restart your computer.
 

If none of the above steps have helped, feel free to contact our support team via e-mail support@movavi.com or live chat.
 
If possible, please include the name of your graphics card model (see Step 1), as well as screenshots of any error messages
you have encountered. This will help our support team specialists solve your problem quicker.
 
 

http://support.amd.com/en-us/download
http://www2.ati.com/drivers/auto/autodetectutility.exe
mailto:support@movavi.com
https://chatserver.comm100.com/ChatWindow.aspx?planId=1190&visitType=1&byHref=1&partnerId=-1&siteid=27345


 

 

Hardware acceleration
Movavi Video Suite is optimized for the latest Intel® and NVIDIA® hardware acceleration technologies.
 
Intel acceleration
Movavi Video Suite supports hardware acceleration provided by Intel® multi-core processors and integrated graphics, which
allows for faster encoding/decoding, as well as simultaneous conversion of a large number of files by employing the full
power of each core. Performance grows up to 400% for H.264 and MPEG-2 codecs and up to 8 files can be processed
simultaneously.
 
Supported Formats
Input Video Formats: AVI, MP4, FLV, MKV, MOV, MPEG2-TS with H.264 codec; MPEG (MPEG2 PS, MPEG2 TS) with
MPEG1/MPEG2 codec; WMV with VC-1 codec.
Output Video Formats: 3GP, 3GP2, AVI, FLV, M2TS, MKV, MP4 with H.264 codec; M2TS, MPEG with MPEG2 codec.
 
NVIDIA acceleration
If your computer is equipped with an NVIDIA® graphics card, you can use it to accelerate media file processing up to 5x
by shifting a part of the workload to the graphics processing unit, freeing up your computer's CPU for other tasks. This
technology supports the newest NVIDIA® graphics cards, including GeForce™, GeForce Mobile, Quadro, and Quadro
Mobile. You can find the full list of supported GPUs on our webpage.
 
Supported Formats:
Input Video Formats: AVI, MP4, FLV, MKV, MOV, MPEG2-TS with H.264 codec, MPEG (MPEG2 PS, MPEG2 TS) with
MPEG1/MPEG2 codec, WMV with VC-1 codec.
Output Video Formats: 3GP, 3GP2, AVI, FLV, M2TS, MKV, MP4 with H.264 codec.
 
Enabling hardware acceleration
To enable Intel or NVIDIA acceleration in Screen Capture, or Video Converter: 
1. Open the Settings menu and select Preferences.
2. In the Preferences window, select the acceleration method that is compatible with your computer.
3. Click OK to accept the changes.
 
To enable Intel or NVIDIA acceleration in the Video Editor module:
1. Open the Edit menu and select Preferences.
2. In the Preferences window, switch to the Acceleration tab.
3. Select the acceleration method that you prefer. For Intel® acceleration, you can choose hardware or software acceleration
methods for each of the supported codecs.
3. Click OK to accept the changes.
 

Troubleshooting
If the acceleration option is unavailable it may mean one of the following:

• Your computer is not equipped with the right hardware
• The driver may be out of date or not installed.

Intel Download Center
Updating graphics card drivers

http://www.movavi.com/videoeditor/performance.html
https://downloadcenter.intel.com/


 

 

SuperSpeed mode
With SuperSpeed mode, you can convert videos much faster to compatible formats. You can use SuperSpeed mode in the
converter and screen capture modules.
 
How does it work?
When you convert videos, encoding the video from one codec to another usually takes the most time. In SuperSpeed mode,
the video can be converted without changing the video codec, simply 'transferring' the video stream from one file to another
with zero quality loss. Converting a file in SuperSpeed mode takes little more than simply copying it.
 
Since SuperSpeed mode does not modify the video stream, you can't use it if you want to add a watermark, adjust the video,
or compress the file to a smaller size.
 
Enabling SuperSpeed
1. Open the application settings and make sure that the Enable SuperSpeed mode option is on.

2. When choosing an output format, select one with the SuperSpeed icon: 
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